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1. Introduction 
 

1.1 About RX-TIMBER 
RX-TIMBER is a DLUBAL program family that meets specific demands in timber engineering. 
With the programs included in the RX-TIMBER package you can design glued-laminated 
beams, continuous beams, columns, frames, purlins and bracings. The governing result com-
binations are created automatically with the add-on module RF-COMBI that is integrated in 
RX-TIMBER. 

All of the RX-TIMBER programs are able to perform the ultimate and the serviceability limit 
state design. The design can be carried out according to the following timber standards: 

• EN 1995-1-1:2004-11 

• DIN 1052:2008-12 

In addition, it is possible to perform the fire protection design according to EN 1995-1-2 or  
DIN 4102, part 22. 

Various national application documents are available for selection for EN 1995-1-1:2004. The 
list shown on the left presents the implemented national annexes (NAs) and is constantly be-
ing expanded. 

RX-TIMBER Glued-Laminated Beam 

The program is used for designing glued-laminated beams with long span lengths. The follow-
ing beam types can be designed: 

• Parallel beam 

• Monopitch roof beam 

• Curved beam 

• Double tapered beam 

• Pitched cambered beam with constant and variable height 

• Fish beam - parabolic or linear with roundings 

Depending on the selected beam type, different input settings are available, allowing you to 
calculate unsymmetric beams with and without cantilevers in various combinations. Moreover, 
you can take account of typical stiffenings for transversal tension such as bonded steel bars. 

RX-TIMBER Continuous Beam 

The program designs multi-span beams with up to 20 spans and cantilevers for biaxial bend-
ing. The loads are generated automatically according to EN 1990 or DIN 1055-100. The options 
for optimization offered in the standards are implemented in the program. The following 
beam types can be designed: 

• Single-span beam 

• Continuous beam 

• Hinged girder system (Gerber) 

For all beam types it is possible to define the support in x-, z- and y-direction. Optionally, you 
can assign moment and shear force releases. 

RX-TIMBER Column 

The program performs the design for columns with a rectangular or circular cross-section. To 
model the connection of a column to a roof truss close to reality, it is possible to define elastic 
supports for the column's head and footing. 

 
 

National annexes for EC 5 
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RX-TIMBER Frame 

The program is able to design symmetrical or asymmetrical three-hinged frames. The coupling 
element is represented by a knee connection with finger joints, optionally calculated with or 
without intermediate piece. When entering the frame geometry, sloping and direction of la-
mellas can be selected freely. 

RX-TIMBER Purlin 

The program designs coupled purlins in roofs. Optionally, you can set the design of couplings 
inactive to analyze nothing but a continuous beam (however, it is not possible to adjust the 
depth of the beam to the moment diagram by using tapers). Wind and snow loads are precise-
ly determined by selecting the roof shape. Coupling elements are provided as nails, special 
timber connectors and bolts according to the WT system by SFS intec, or by a user-defined 
load bearing capacity. 

RX-TIMBER Brace 

This program is used to design the bracing of a roof structure. The brace can be defined by 
means of three roof constructions and adjusted at will. As steel diagonals are often used for a 
roof bracing, the program provides also steel cross-sections. The material nonlinearities of ten-
sion members as well as the reduction of stiffness are automatically considered in the ultimate 
limit state design. 

Find information about news and developments of the timber programs and add-on modules 
on our homepage www.dlubal.com. 

We hope you will enjoy working with the programs of the RX-TIMBER family. 

Your team from DLUBAL SOFTWARE GMBH 

1.2 Company Profile 
Since its beginnings in 1987, DLUBAL SOFTWARE GMBH has been involved in the development of 
user-friendly and powerful programs for structural and dynamic analysis. In 1990, the company 
moved into its current location which is Tiefenbach in Eastern Bavaria. A local branch exists 
since 2010 in Leipzig. 

When looking at our programs you can feel the enthusiasm of everybody involved in the soft-
ware development, and you will notice the underlying philosophy of all our applications, 
which can be expressed in one word: user-friendliness. These two points combined with our 
expertise in engineering are forming the base for the ever-growing success of our products. 

DLUBAL software has been designed in such a way that even users with basic computer skills 
can handle the software successfully after a short while. With considerable pride, we now 
number more than 7,000 engineering offices as well as construction companies from a variety 
of fields and places of higher education all over the world among our satisfied customers. To 
remain true to our objectives, there are more than 150 internal and external employees work-
ing continuously on the development and improvement of DLUBAL applications. In case of 
questions and problems, our customers can always rely on our qualified fax and email hotline. 

The perfect balance between price and performance combined with excellent customer ser-
vice provided by experienced civil engineers make DLUBAL programs an essential tool for any-
one working in the areas of structural engineering, dynamics and design. 

http://www.dlubal.com/
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1.3 RX-TIMBER Team 
Program coordination 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) Bastian Kuhn 

Ing. Jiří Hanzálek 
Dipl.-Ing. (FH) Younes El Frem 

Programming 
Ing. Martin Deyl 
Dipl.-Ing. Georg Dlubal 
Ing. Tomáš Ferencz 

Mgr. Jaroslav Krul  
Mgr. Jiří Patrák 

Program design, dialog figures and icons 
Dipl.-Ing. Georg Dlubal 
Ing. Jan Miléř 

MgA. Robert Kolouch 

Program supervision 
Ing. Jiří Hanzálek 
Dipl.-Ing. (FH) Bastian Kuhn 
Ing. Vladimír Kabát 

Ing. Zdeněk Kodera 
Ing. Vladimír Pátý 

Localization and manual 
Ing. Fabio Borriello 
Ing. Dmitry Bystrov 
Eng.º Rafael Duarte 
Ing. Jana Duníková 
Ing. Lara Freyer 
Alessandra Grosso 
Ing. Ladislav Kábrt 
Ing. Aleksandra Kociołek 
Dipl.-Ing. (FH) Bastian Kuhn 

Ing. Roberto Lombino 
Eng.º Nilton Lopes 
Ing. Téc. Ind. José Martínez 
MA SKT Anton Mitleider 
Dipl.-Ü. Gundel Pietzcker 
Ing. Zoja Rendlová 
Ing. Marcela Svitáková 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Marcin Wardyn 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. (FH) Bastian Kuhn 

Dipl.-Ing. (FH) Ulrich Lex 
M. Eng. Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Gerhard Rehm 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 

1.4 Using the Manual 
Many roads lead to Rome – this policy also applies to working with RX-TIMBER. The descrip-
tions in this manual follow the sequence and structure of the tables available in the RX-TIMBER 
programs. The first chapters describe general program functions such as file management, ta-
ble arrangements and printout. Beginning with chapter 10, the manual presents the individual 
programs by describing examples. 

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are shown in the left margin. In addition, expressions used in dialog 
boxes, tables and menus are set in italics to clarify the explanations. 

The index at the end of the manual helps you to find specific terms and subjects. However, if 
you don’t find what you are looking for, please check our website www.dlubal.com where you 
can go through our FAQ pages by selecting particular criteria. 

 

http://www.dlubal.com/
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2. Installation 
 

2.1 System Requirements 

The following system requirements are recommended in order to use RX-TIMBER without any 
difficulties: 

• Operating system Windows XP/Vista/7/8 

• x86 CPU with 2 GHz 

• 2 GB RAM 

• DVD-ROM drive for installation (alternatively a network installation is possible) 

• 10 GB hard disk capacity, including approximately 1 GB required for installation 

• Graphic card with OpenGL acceleration and resolution of 1024 x 768 pixels. Onboard  
solutions and shared-memory-technologies are not recommended. 

RX-TIMBER is not supported by Windows 95/98/Me/NT/2000, Linux, Mac OS or server operat-
ing systems. 

No product recommendations are made – with the exception of the operating system – as  
RX-TIMBER basically runs on all systems that fulfill the system requirements mentioned above. 
If RX-TIMBER is used for intensive calculations, the guiding principle 'the more, the better' 
applies. 

2.2 Installation Process 
The program family RX-TIMBER is delivered on the DVD called Stand-Alone Applications. The 
DVD contains the stand-alone programs RX-TIMBER, CRANEWAY, COMPOSITE-BEAM and 
PLATE-BUCKLING. The installation of RX-TIMBER includes all programs that are available in the 
RX-TIMBER product range. 

Before you install RX-TIMBER, close all applications running in the background.  

Please make sure that you are logged on as administrator or to have administrator rights for 
installing the program. When working with RX-TIMBER, user rights will be sufficient. For de-
tailed instructions, see the user rights video on our website. 

 

 

http://download.dlubal.com/?file=videos/allgemein/user_rights.avi
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Program selection 

2.2.1 Installation from DVD  
On the back side of the DVD case, you can find installation instructions. 

• Insert the DVD into your DVD-ROM drive. 

• The installation process starts automatically. If it does not start, the autorun function is 
probably deactivated. In this case, start the file setup.exe on the DVD either in the Ex-
plorer or by entering the command ‚D‘:\setup.exe in the input field of the start menu  
(‚D‘ refers to the drive letter of your DVD drive). 

• In the start dialog box, select the language. 

 
Figure 2.1: Language settings 

• In the next dialog box, define the program version (64-bit or 32-bit). 

• Follow the instructions of the Installation Wizard. 

Connect the dongle to a USB port of your computer only after the installation is complete.  
The dongle driver will be installed automatically. 

Moreover, the DVD contains instructions for installation and the RX-TIMBER manual in PDF 
format. To open it, you need the Acrobat Reader that you can install from the DVD. 

RX-TIMBER as full or trial version 
When you start the program for the first time after the installation has been completed suc-
cessfully, you have to decide if you want to use RX-TIMBER as a full version or a trial version 
running for 30 days. 

To use this program as full version, you need a dongle (hardlock) and an authorization file Au-
thor.ini. The dongle is a plug-in device that you have to connect to a USB port of the computer; 
the authorization file contains coded information for your license(s). Usually, we send you the 
Author.ini file via e-mail. You can also use the Extranet on www.dlubal.com to access the au-
thorization file. Save this Author.ini file on your computer, an USB flash drive, or in the network. 

The authorization file is needed for every work place. You can copy the file as often as you like. 
If, however, the content of this file is changed, the authorization becomes invalid. 

It is also possible to run the full version of RX-TIMBER as a softlock licence without dongle. 
 

http://www.dlubal.com/extra/loginpage.aspx
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2.2.2 Network Installation 
Local licenses 

The installation can be started from any drive of your computer or server. First, copy the con-
tents of the DVD to the relevant folder. Then, start the file setup.exe from the client. The follow-
ing steps do not differ from the DVD installation. 

Network licenses 

In case of network licenses, install the program on the work stations as described. Then, the  
licenses will be approved by the SRM network dongle. Find detailed information about in-
stalling the network dongle in the instructions available on our website. 

2.2.3 Installing Updates and Other Programs 
The DVD contains the complete program package of RX-TIMBER together with other stand-
alone programs. When purchasing a new add-on module, you will not necessarily receive a 
new DVD but always a new authorization file Author.ini. To update the authorization without 
reinstallation, select Load Authorization File on the Help menu in the respective RX-TIMBER 
program. 

Old program files are removed and replaced by new ones when updating the program within 
one series of a version (for example 2.02.xxxx). Of course, your project data is preserved! When 
updating the program to the next series (for example 2.03.xxxx) the new version will be in-
stalled parallel to the old version (see below). 

If you use printout report headers that you have defined yourself, save them before installing 
the update. The headers are usually stored in the file DlubalProtocolConfig.cfg that you find 
in the general master data folder C:\ProgramData\Dlubal\Stammdat. The file won’t be over-
written during the update. Nevertheless, saving a backup file may be useful. 

We also recommend to save your report templates before you install the update. They are 
stored in the file RfemProtocolConfig.cfg in the folder C:\ProgramData\Dlubal\RX-TIMBER 2.xx\ 
General Data. 

The projects linked in the Project Manager are managed in the ASCII file PRO.DLP which can 
normally be found in the folder C:\ProgramData\Dlubal\ProMan (see Figure 4.19, page 25). If 
you want to uninstall RX-TIMBER before installing the update, you should save this file, too. 

2.2.4 Parallel Installation of Dlubal Programs 
The DLUBAL applications RX-TIMBER 1 and the individual series of version RX-TIMBER 2 can be 
run parallel on the computer since the program files are stored in different directories. The de-
fault folders are the following for a 64-bit operating system: 

• RX-TIMBER 1: C:\Programs (x86)\Dlubal\RX-TIMBER1 

• RX-TIMBER 2.01 C:\Programs\Dlubal\RX-TIMBER 2.01 

• RX-TIMBER 2.02 C:\Programs\Dlubal\RX-TIMBER 2.02 

• RX-TIMBER 2.03 C:\Programs\Dlubal\RX-TIMBER 2.03   etc. 

All models created with RX-TIMBER 1 can be opened and edited in RX-TIMBER 2. 

Models from RX-TIMBER 1 won’t be overwritten when saving them in RX-TIMBER 2 because 
both programs use different file endings: RX-TIMBER 1 saves model data in the format *.rh1, 
RX-TIMBER 2 in *.rh2. 

RX-TIMBER uses the analysis core of RFEM but is installed independently of RFEM. Thus, it runs 
stand-alone: An RFEM installation is not required. 

A model created with RX-TIMBER can be opened in RFEM or RSTAB. 

 

 

http://ng.dlubal.de/files/53216.pdf
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3. Principles for RX-TIMBER 
 

3.1 Restrictions 
Please note the following comments. In this way, you can avoid assuming automatisms that 
are not given in RX-TIMBER. 

The concept of the software aims at avoiding unnecessary input. Therefore, defining snow and 
wind loads has been simplified as far as possible by integrated load generators. But as you may 
understand, considering all options of variation is not possible. The following items must be 
taken into account: 

• When generating loads the program acts on the assumption of a hall whose sides are 
closed. Wind loads from roof-lifting internal wind can be taken into account for halls that 
are open on one side by the option with Permeable Walls. 

• Blowings and slippings of snow loads must be defined manually. 

• RX-TIMBER Glued-Laminated Beam does not generate any horizontal load from wind 
and earthquakes on the gable. 

• The wind load in RX-TIMBER Continuous Beam is always determined for the maximum 
possible value of loading. For this purpose the program determines always the maximum 
and minimum stressed area of the respective geometry. 

3.2 Start RX-TIMBER 
To start the program, use the Windows Start menu or the Dlubal icon on the desktop. 

File management and Project Manager are described in chapter 4. 

The relevant RX-TIMBER program starts automatically after creating a new model or by double-
clicking a model that is already available. 
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4. File Management 
This chapter explains how data is organized in the Project Manager. In addition, the chapter 
describes the data import and export with the interfaces integrated in RX-TIMBER for exchang-
ing data with other programs. 

After starting the program on the Start menu in Windows or by clicking the RX-TIMBER icon, 
the Project Manager appears where you can create new models or select files that are already 
available. 

The Project Manager provides access to the individual timber programs of the RX-TIMBER 
family. 

4.1 Project Manager 
In structural analysis a project is often subdivided into several models. The Project Manager 
helps you to organize data of your Dlubal applications. You can also use it for managing mod-
els within the network (see chapter 4.3, page 27). 

The Project Manager can be left open as a stand-alone application when working in RX-TIMBER. 

When you open the Project Manager, the following multi-part window appears. It has its own 
menu and toolbar. 

 
Figure 4.1: Project Manager 

Project navigator 

A navigator listing all projects in a tree structure is displayed on the left. The current project is 
set bold. To select another project, double-click the relevant entry, or use the list Current Pro-
ject in the toolbar. The table to the right of the navigator lists the models contained in the se-
lected project. 
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RX-TIMBER programs 

All programs of the RX-TIMBER family are displayed below the Project Navigator. They repre-
sent a filter possibility that can be used to show only the models that belong to a particular 
timber program. 

For example, if you select Glued Laminated Beam, the Manager shows only the model files in 
the right part of the window that were created with the program RX-TIMBER Glued Laminated 
Beam. To create a new model in the program, click it with the right mouse button. 

Table of models 

The models are arranged in several tabs, sorted by Dlubal applications. The tab RX-TIMBER lists 
all RX-TIMBER models contained in the selected project. The Model Name and Description as 
well as significant model and file information including name of the user who created and  
edited the model are displayed. 

To adjust the column display, select Manage Register Columns on the View menu of the  
Project Manager, or use the toolbar button shown on the left (see page 23). 

Details 

This part of the window shows all information available for the model that is selected in the 
window section above. 

Preview 

The selected model is displayed in a preview. The size of the preview window can be adjusted 
by moving the upper edge of the window. 

Thumbnails 

The bottom area of the Project Manager offers you a graphical overview about the models 
contained in the selected project. The thumbnail images are interactive with the table above. 

Use the pins to minimize particular window parts. They will be docked as tabs in the footer. 

4.1.1 Project Management 

Create a new project 
To create a new project, 

• select New on the Project menu or 

• click the button [New Project] in the toolbar shown on the left. 

 
Figure 4.2: Button New Project 

The dialog box Create New Project opens where you enter the Name of the new project. Then, 
select the Folder in which you want to save the models. Use the [Browse] button shown on the 
left to set the directory. You can also add a short project Description. It will be shown in the 
header of the printout report and has no further relevance. 
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Figure 4.3: Dialog box Create New Project 

It is also possible to create sub-projects in the Project Manager by selecting a project in the list 
Place project under. The new project will be displayed as sub-project in the navigator. If you do 
not want to use this setting, select the list entry Projects on the top of the list. Then, the project 
will appear as main entry in the navigator. 

After clicking [OK], a new folder with the project name will be created on the local or network 
drive. 

Connect an existing folder 
To integrate a folder already containing several RX-TIMBER models as a project, 

• select Connect Folder on the Project menu of the Project Manager or 

• use the button [Connect Folder] in the toolbar shown on the left. 

 
Figure 4.4: Button Connect Folder 

It is irrelevant on which local or network drive the folder that you want to connect is located.  
It will be included into the file management and left at its location – similar to the creation of a 
shortcut on the desktop. The information is saved in the ASCII file PRO.DLP in the ProMan 
folder (see chapter 4.1.4.3, page 25). 

A dialog box opens that is similar to the dialog box shown in Figure 4.3. Enter the Name and 
Description of the project, and use the [Browse] button to set the directory for the relevant 
Folder. If a project is specified in the list Place project under, the connecting folder must be con-
tained within the directory of this project. The folder will then be managed as a sub-project. 
But if you want the folder to appear as an independent project in the Project Manager, select 
Projects on the top of the list. 

Tick the option Connect folder including all subfolders to connect all folders contained in the 
selected folder at once with the management of the Project Manager. 

 



4  File Management 

 

 

16 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

Disconnect a folder 
To disconnect a folder integrated in the project management, 

• select Disconnect on the Project menu of the Project Manager (project must have 
been previously selected) or 

• use the project's context menu in the navigator. 

 
Figure 4.5: Context menu of a project 

The project will be removed only from the internal management. The folder on the hard disk 
and its contents will be kept. 

Delete a project 
To delete a project, 

• select Delete on the Project menu of the Project Manager (project must have been  
previously selected) 

• click the [Delete] button in the toolbar shown on the left 

• use the project's context menu in the navigator (see figure above). 

 
Figure 4.6: Button Delete 

The folder including its contents will be completely deleted from the hard disk. 

If the folder contains also files from other programs, only the files of Dlubal applications will be 
deleted. The folder itself will be preserved. 

To undo the deletion of projects, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

The Dlubal recycle bin is described in chapter 4.1.4.2 on page 24. 
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In case files stored on a network drive are deleted, they are copied via network into the Dlubal 
recycle bin on the hard disk, which is different to the Windows standard where data is irrecov-
erable. In this way, you can restore files deleted on network drives from the relevant computer. 
If you don't want the files to be copied into the recycle bin, we recommend to simply discon-
nect the project (see above). Then, you can delete the data from the network drive manually. 

Copy a project 
To copy a project, 

• select Copy on the Project menu of the Project Manager (select project previously) or 

• use the Copy entry in the project's context menu in the navigator (see Figure 4.5). 

 
Figure 4.7: Dialog box Copy Project 

Enter the Name, Description and the location of the new project in the Project Manager, and 
define the Folder that will be created by the copy function. 

It is also possible to copy the project with the Windows-Explorer. Then, you can integrate the 
new folder as a connected folder into the management of the Project Manager (see chapter 
Figure 4.4, page 15). 

Rename a project / change description 
To change the description of a project subsequently, 

• select Properties on the Project menu of the Project Manager (select project previously) 
or 

• use the Properties entry in the project's context menu in the navigator (see Figure 4.5). 

The dialog box Project Properties opens where you can change the Name and Description of the 
project. The Folder of the project is also displayed. 

 
Figure 4.8: Dialog box Project Properties 
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Import a project folder 
After changing the computer, you can restore the complete directory tree of the Project Man-
ager without copying the file PRO.DLP (see chapter 4.3, page 27). All projects included in a 
folder will be entered in the project management (which means that this folder must contain 
projects, not models). In this way, the projects do not need to be connected individually. 

To open the dialog box for importing a project folder, 

select Import Folder on the Project menu of the Project Manager. 

 
Figure 4.9: Dialog box Import folder 

In the list Place projects under, define the way how you want to integrate the project folder into 
the management. If you want the folders to appear as independent projects in the Project 
Manager, select the list entry Projects on the top of the list. Use the [Browse] button shown on 
the left to set the directory for the Folder to be linked. 

Tick the option Connect folders including all subfolders to integrate all subfolders of the folders 
into the management of the Project Manager. 
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4.1.2 Model Management 

Open a model 
To open a model out of the Project Manager, 

• double-click the model name or its thumbnail image, 

• select Open on the Model menu of the Project Manager (model must have been previ-
ously selected) 

• or use the context menu of the model. 

 
Figure 4.10: Context menu Model 

Use the context menu option Open With shown on the left to select a particular Dlubal applica-
tion with which you want to open the model. 

It is also possible to open RX-TIMBER files directly in RFEM or RSTAB. 

Shift / copy a model 
To copy a model to another project, 

• select Copy on the Model menu (model must have been previously selected), 

• use the Copy entry in the model's context menu (see figure above) or 

• use the drag-and-drop function by holding down the [Ctrl] key. 

In the dialog box Copy Model (see figure below), specify the target project and enter the Name 
and Description for the copy of the model. 

To shift a model, hold the left mouse button down when moving it into another folder. 
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Figure 4.11: Dialog box Copy Model 

Rename a model 
To rename a model, 

• select Properties on the Model menu of the Project Manager (model must have been 
previously selected) or 

• use the Properties entry in the model's context menu in the navigator (see Figure 4.10). 

 
Figure 4.12: Dialog box Model Properties 

In the dialog box Model Properties, you can change the Name and Description of the model.  
The File name and the model's directory are also displayed. 

If the model contains also results and printout reports, you can remove such additional Data 
from the data record by using the [Delete] button. 

Delete a model 
To delete a model, 

• select Delete on the Model menu of the Project Manager (select model previously), 

• click the [Delete] button in the toolbar shown on the left or 

• use the context menu of the model (see Figure 4.10). 

In the context menu, it is also possible to Delete Results and/or to Delete Printout Reports of the 
model specifically. In both cases, input data remains available. 

To undo the deletion of models, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

The Dlubal recycle bin is described in chapter 4.1.4.2 on page 24. 
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Show the history 
To check the history of a model, 

• select History on the Model menu of the Project Manager (select model previously) or 

• use the History entry in the model's context menu (see Figure 4.10). 

 
Figure 4.13: Info window History of Model 

A dialog box appears showing information about the users who created, opened or modified 
the model. The overview includes also the time when the individual actions were carried out. 

4.1.3 Data Backup 

Archive data 
You can back up selected models or even an entire project folder in a compressed backup file. 
The original models remain available. 

To start the archiving process, 

• select Make Archive on the Archive Data menu of the Project Manager (model or pro-
ject must have been previously selected) or 

• use the context menu of the project or model (see Figure 4.10). 

 
Figure 4.14: Dialog box Archive 
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The backup file can be generated with or without results and printout reports. Further options 
allow for the integration of subprojects and files that do not belong to any of the Dlubal appli-
cations. 

When the Name and Folder of the archive file are defined, you can create a ZIP file by clicking 
[OK]. 

Extract from archive 
To extract data from the archive, 

select Extract Project/Models from Archive on the Archive Data menu of the Project 
Manager. 

The Windows dialog box Open appears where you can select the ZIP backup file. After clicking 
[OK], the contents are displayed. 

 
Figure 4.15: Dialog box Extract Project with Models from Archive 

In the dialog section Select Models to Extract, select the models that you want to restore. They 
can be unpacked with either the original project settings or as new project. In the list Place pro-
ject under, you can define the ranking in the management structure of the Project Manager.  
Alternatively, you can create a new directory by means of the [Browse] button. 
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4.1.4 Settings 

4.1.4.1 View 

Show thumbnails and details 
The window area below the model table can be adjusted according to your preferences. You 
can choose two options for additional windows that can be activated independently of each 
other. 

To set the display options, 

select Pictures Preview of All Models on the View menu and 

select Details of Current Models on the View menu of the Project Manager, 

or use the respective toolbar buttons. 

Button Function 

 
Shows thumbnail images of all models in the project 

 
Shows model details and preview of model 

Table 4.1: Buttons for setting the view 

Sorting models 
The arrangement of models in the table can be adjusted: As usual with Windows applications, 
you can sort the list in an ascending or descending order by clicking into the column titles. Al-
ternatively, you can 

select Sort Models on the View menu. 

Adjust columns 
To arrange the columns according to your needs, 

• select Manage Register Columns on the View menu of the Project Manager 

• or use the button [Manage Register Columns] in the Manager toolbar shown on the left. 

 
Figure 4.16: Dialog box Manage Register Columns 

RX-TIMBER is preset in the Register dialog section. In the list Columns - Available, you can select 
the relevant entries to transfer them to the list Columns - To Display. Use the arrow buttons [] 
for the transfer. You can also double-click the items. Columns that you don't want to be dis-
played can be hidden with the [] buttons. 
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The order of columns in the models list can be changed by using the buttons [] and [] in 
the list Columns - To Display. Click them to shift a selected entry up and down. 

To optimize the column widths in the models list, select Arrange Automatically on the View 
menu of the Project Manager. You can also use the toolbar button shown on the left. 

4.1.4.2 Recycle Bin 
To restore deleted projects and models, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

A dialog box appears where all deleted models are listed by projects. 

 
Figure 4.17: Dialog box Restore Models from Dlubal Recycle Bin 

The models to be restored can be selected by mouse click. With the button [Select All] you can 
tick the entries all at once. Click the button [Restore Selected Models] to insert the deleted 
models into the original project folders. 

To delete models stored in the Dlubal recycle bin, 

select Empty Dlubal Recycle Bin on the Edit menu of the Project Manager. 

Before the hard delete is performed, a security query is displayed. 

To adjust the settings for the Dlubal recycle bin, 

select Settings for Dlubal Recycle Bin on the Edit menu of the Project Manager. 

A dialog box appears where the settings for storage location and memory size are managed. 
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Figure 4.18: Dialog box Settings for Dlubal Recycle Bin 

4.1.4.3 Directories 
The directories of the Project Manager can be checked in the Settings. To open the correspond-
ing dialog box, 

select Program Options on the Edit menu of the Project Manager. 

 
Figure 4.19: Dialog box Settings 

Folder and file name of the category Project Manager are displayed in the input field below 
where they can be adjusted, if necessary. All projects are managed in the file PRO.DLP which 
can normally be found in the folders C:\ProgramData\Dlubal\ProMan (Windows 7) or 
C:\Documents and Settings\All Users\Application Data\Dlubal\ProMan (Windows XP). The 
[Browse] button helps you to set another path. 

As the Project Manager is network-compatible, it is possible to organize the data management 
for the models contained in the Project Manager in a central place: Set the directory to the 
PRO.DLP file on the server (see chapter 4.3, page 27).  

The dialog section Options offers more settings for handling RX-TIMBER files: Usually, a message 
appears when opening a file out of the Explorer, an e-mail program etc. if the related folder is 
not integrated in the management of the Project Manager. The message can be deactivated. 
Moreover, you can decide which program version you want to use to create or open model 
files. 
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4.2 Creating a New Model 
First, go to the Modules section in the Project Manager (see Figure 4.1, page 13) where you  
select the program that you want to use for calculating a new model. 

To create a model, 

• click the toolbar button [New Model] shown on the left or 

• point to New With on the Model menu, and then select RX-TIMBER 2. 

 
Figure 4.20: Button New Model 

The dialog box New Model for RX-TIMBER - General Data opens. 

 
Figure 4.21: Dialog box New Model for RX-TIMBER - General Data 

When you want to edit the model's general data later, 

• select Properties on the Model menu of the Project Manager (model must have been 
previously selected) or 

• use the Properties entry in the model's context menu in the navigator (see Figure 4.10, 
page 19). 

Model name / description 
Enter a name into the input field for Model Name. At the same time, it is used as the model's file 
name. By entering a Description you can describe the model in detail. It will be shown in the 
header of the printout report but has no further relevance. 

 
Figure 4.22: Model description in printout report 

Project name / description 
In the Project Name list, you can select the project folder where the model will be created. The 
current project is preset. If required, you can change the presetting in the Project Manager (see 
chapter 4.1.1, page 14). 

In addition, the Description and Folder of the selected project are displayed for information. 
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4.3 Network Management 
When several users are working on the same projects, model management can be organized 
by the Project Manager, provided that the models are stored in a folder that is accessible on 
the network. 

First, connect the network folder to the internal project management. Please find a description 
in chapter 4.1.1 on page 15. Now, you can directly access the models of this folder in the Pro-
ject Manager, which means that you can open or copy the models, check their history or pro-
vide them with a write protection. 

If another user is already working on the model that you want to open, a warning appears. In 
this case, you can open the model as a copy. 

 
Figure 4.23: Query to open the model 

An automatic data synchronization of modifications is not possible. 

Information about the projects registered in the Project Manager is stored in the file PRO.DLP. 
This is an ASCII file which is normally located under C:\Documents and Settings\All Users\Appli-
cation Data\Dlubal\ProMan (Windows XP) or C:\ProgramData\Dlubal\ProMan (Windows 7). 

By copying the PRO.DLP file to another computer you can avoid connecting folders project by 
project. In addition, the file can be edited by an editor. This facilitates the import of all relevant 
project folders into the internal file management of the Project Manager, especially after new 
installations. As an alternative, you can use the function Import Folder (see chapter 4.1.1, page 
18). 

Before copying the PRO.DLP file - like before uninstalling Dlubal applications - it is recom-
mended to save the existing file. 

The Project Manager is network-compatible. The file management can be organized in a cen-
tral place so that all users are integrated in one common project management. To define the 
network settings, 

select Program Options on the Edit menu of the Project Manager. 

A dialog box opens where you can define the storage location for the file PRO.DLP (see Figure 
4.19, page 25). 

The Project Manager runs on every local computer, but each is using the central server file 
PRO.DLP. In this way, all users can carry out modifications to the project structure at the same 
time. For write access to the PRO.DLP file, the file is locked only for a short time and is unlocked 
immediately afterwards. 
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5. Input 
The input windows are presented using RX-TIMBER Glued Laminated Beam as an example 
program. 

First, you have to create or open a model (see chapter 4.2, page 26) before you can start enter-
ing model and load data.  

The program window of the selected RX-TIMBER program appears. On the left, a navigator 
managing the available windows is displayed. The term "window" refers to the central part of 
the window where you can specify data for the model and check the result details listed in the 
output after the calculation. 

 
Figure 5.1: RX-TIMBER Glued laminated beam, window 1.1 Beam Type and Material 

To go to a particular window, click its entry in the navigator. Use the buttons shown on the left 
to set the previous or next window. Alternatively, you can use the function keys [F2] (next) or 
[F3] (previous) to browse through the windows. 

To save the input and exit the timber program, click [OK]. If you click [Cancel], you exit the pro-
gram but without saving the data. 

The buttons below the window have the following functions: 

Button Function 

 Starts the calculation 

 Opens a dialog box with detailed settings ( chapter 6.1) 

 Opens the standard parameters for the national annex ( chapter 6.2) 

 Displays the print preview ( chapter 8) 

 Opens the add-on module RF-COMBI ( chapter 6.3) 

Table 5.1: Default buttons 
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5.1 Beam Type and Material 
When you have started the program, window 1.1 Beam Type and Material is displayed (see Fig-
ure 5.1) where you enter the basic settings for the beam that you want to design. The beam is 
additionally shown in a graphic.  

Beam type 
The dialog section Beam Type offers you eight beam types for selection: 

• Parallel beam 

• Monopitch roof beam 

• Double tapered beam 

• Curved beam 

• Pitched cambered beam with constant height 

• Pitched cambered beam with variable height 

• Fish beam - parabolic 

• Fish beam - linear with roundings in central area 

Depending on the beam type, up to four options are available below the list. These options 
allow you to specify the geometry in detail: 

• Asymmetric layout 

• With cantilevers: horizontal, parallel, taper or offset 

• Capped with loose ridge wedge 

• Notch on supports 

The following table provides an overview about the possibilities how different beam types can 
be defined: 
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Horizontal Parallel Taper Offset 

1   x x x   

2  x  x x   

3 x x  x x  x 

4 x x x x x  x 

5 x x x x x x x 

6 x x x x x x x 

7   x x x   

8   x x x   

Table 5.2: Overview about beam types 
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According to standard / national annex 
The design standard is defined uniformly for all types of design. Two timber standards are 
available for selection. 

 
Figure 5.2: Selection of design standard 

When EN 1995-1-1:2004 is set, you can select the National Annex from the list to the right. 

 
Figure 5.3: Selection of national annex 

Use the [Edit] button to check the factors of the selected national annex. If necessary, you can 
adjust the coefficients. 

 
Figure 5.4: Dialog box National Annex Settings, tab General 

The dialog box is described in detail in chapter 6.2 on page 56. 
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Material 
In the window section Material, you can select the relevant timber grade in a list. The program 
provides standardized material grades for glued laminated timber according to EN 1995-1-1: 
2004-11 and DIN 1052:2008-12. 

 
Figure 5.5: Selection of strength class for glued-laminated timber 

Use the [Library] button to access the material library where you can check the material prop-
erties used for the calculation. The predefined timber grades cannot be edited. In this way, it is 
ensured that the material properties used by the program correspond to the ones of the dis-
played timber class. 

 
Figure 5.6: Material Library 

To create a user-defined timber grade, click the [New] button in the library. The dialog box 
New Material opens. The parameters of the entry selected in the list Material to Select are pre-
set. Creating a new material is easier when you choose a material with similar properties be-
fore you access the dialog box. Enter the Material Description, define the Material Properties, 
and assign the material to the Filter categories. The new timber grade is now available for all 
RX-TIMBER calculations. 

You can also [Edit] or [Delete] user-defined materials in the library via the buttons. 
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Stiffening elements for transversal tension 
In the window section Stiffening Elements for Transversal Tension, you decide if you want to take 
into account a stiffening for transversal tension. The setting is only relevant for the beam types 
3 to 6. For the remaining beam types, the option is set inactive. 

If the Apply check box is ticked, you can choose between 

• constructive if required 

• full absorption of tension stresses perpendicular to the grain. 

If the first option is selected, the program checks if a structural stiffening for transversal tension 
according to the standard's specifications is required and must be taken into account, where 
applicable. If the second option is selected, the entire transversal tension stress is absorbed by 
stiffening elements, irrespective of whether a stiffening would be structurally needed. 

The following stiffening elements can be defined for the transversal tension stiffening: 

• Bonded steel bars 

• Steel bars with wood-screw thread 

• Bonded solid wood or wood-based strips 

• Bonded wood-based plates 

Use the [Setting] button in this dialog section to access the definition parameters for the 
selected element. 

Bonded steel bars 

 
Figure 5.7: Dialog box Stiffening Elements - Glued-in Steel Bars 
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In the dialog section Layout of Steel Bars, you decide how the steel bars are arranged. The fol-
lowing three layouts are available for selection: 

• Determine quantity 
RX-TIMBER automatically calculates the number of required steel bars and the spacings 
resulting from it. 

• Define quantity 
 Define the number n1 of steel bars to be used. RX-TIMBER tries to perform the design 

with the specified setting. The members will be distributed automatically over the 
length c (see dialog graphic). 

• Define spacing 
Define the spacing a1 for the bars. RX-TIMBER determines the required number of bars 
and tries to incorporate them considering the specified spacing. 

Irrespective of the selected layout, you can specify the number n of steel bars within the length 
a1. The bars in the layout can be arranged side by side as well as offset to each other. 

The dialog section Diameter and Material defines the properties of the steel bars. You can spec-
ify the Outside diameter dr of the steel bars, the Strength class as well as the Screw load bearing 
capacity and the Gap-filling strength. More detailed settings are available: When specifying the 
outside diameter, an appropriate Size of bore db will be indicated automatically. If necessary, it 
can be adjusted in order to consider special methods of production for the calculation. 

With the [Edit] button you can set the Partial factor γM2 and the Connection partial factor γM: The 
dialog box National Annex Settings opens (see Figure 6.3, page 56) where you can adjusted the 
factors. 

In case of a complete absorption of tension stresses perpendicular to the grain, the program 
designs the stiffenings according to EN 1995-1-1/NA:2010, equation (NA.95a) or (NA.95b). 
Equation (NA.95b) is tantamount to increasing the spacings of the stiffening for transversal 
tension by 50 %. Therefore, the factor 1.5 is used for a full absorption in the outside area. 

In case of a structural stiffening, the program distributes the bars uniformly over the entire 
cross-section. 

When number or spacing are user-defined, the beam graphic in window 1.2 Geometry also rep-
resents the corresponding steel bars (see Figure 5.10, page 36). When they are determined by 
the program, a visualization will be available only after the calculation. 

Steel bars with wood-screw thread 

The settings in the dialog box for defining steel bars with wood-screw threads are similar to 
the ones described above (see Figure 5.7). But now you specify the Nominal diameter of steel 
bars instead of the outside diameter. 
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Bonded solid wood or wood-based strips 

 
Figure 5.8: Dialog box Stiffening elements - Bonded solid wood or agglomerated wood strips 

In the dialog section Layout of Wood Material Strips, you decide how the strips are arranged. 
Three layouts are available for selection: 

• Determine quantity 
RX-TIMBER automatically calculates the number of required solid wood or wood-based 
strips and the spacings resulting from it. 

• Define quantity 
 Define the number n1 of wood strips to be used. RX-TIMBER tries to perform the design 

with the specified setting. The assumed distribution of strips is represented in the 
graphic. 

• Define spacing 
Define the spacing a1 for the strips. RX-TIMBER determines the required number of strips 
and tries to incorporate them considering the specified spacing. 

The dialog section Dimensions and Material defines the properties of the wood strips. First, 
specify the Length lr in relation to the beam's longitudinal axis as well as the Thickness tr of the 
strips. In addition, decide whether the strips are made of Solid wood or Plywood. If solid wood is 
selected, the program assumes that the grain of the wood strips runs perpendicular to the 
beam's longitudinal axis. The Tensile strength ft,k and the Safety factor γM of the selected timber 
strength class are indicated for information. 

The Joint strength fk3,k defines the force transmission between wood strips and beam. 

If plywood is selected, you can change the Safety factor γM by using the [Edit] button: The dia-
log box National Annex Settings opens (see Figure 6.3, page 56) where you can adjust the fac-
tor. 
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Bonded wood-based plates 

 
Figure 5.9: Dialog box Stiffening Elements - Bonded Agglomerated Wood Plates 

In the dialog section Dimensions, the Length lr of the bonded wood plates is specified: It repre-
sents the length of the curved beam axis resulting from the settings entered in window 1.2 
Geometry. The Thickness tr of the plates can be user-defined.  

The Strength class list in the dialog section Material offers you, in addition to the timber grade, 
settings for a parallel or square arrangement of wood plates. The Tensile strength ft,k used for 
the calculation is indicated for information. 

With the [Edit] button you can set the Partial factor γM: The dialog box National Annex Settings 
opens (see Figure 6.3, page 56) where you can adjusted the factor. 

The Joint strength fk3,k defines the possible force transmission between wood plate and beam. 

Comment 
In the dialog section Comment of window 1.1 Beam Type and Material, you can enter a com-
ment for example to describe the beam in detail. The comment appears in the printout report, 
too. 
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5.2 Geometry 
In window 1.2 Geometry, you define the beam geometry based on the beam type that you 
have selected in window 1.1 Beam Type and Material. Depending on your choice and the se-
lected additional options (asymmetric, with/without cantilever, lose ridge wedge), the follow-
ing parameter groups are displayed: 

• Building dimensions 

• Roof beam geometry 

• Cantilevers (left/right) 

• Cross-section 

• Data for lateral buckling 

• Attic left 

• Attic right 

• Information parameters 

 
Figure 5.10: Window 1.2 Geometry 

To have a clear data overview, you can open and close the groups by a simple click on the [-] or 
[+] sign indicated at the beginning of each group name. 

Each parameter is interactive with the graphic to the right. The relevant value is highlighted in 
color in the outline of the building or beam. 

Building dimensions 
The Building Dimensions group (see Figure 5.10) is the same for all beam types. Its parameters 
are needed for the automatic load determination of wind and snow loads (Building Height H 
and Building Depth B) as well as for the definition of the application area (Beam Spacing a and 
Distance to Roof Edge ü). 

The Distance to Roof Edge ü allows you to consider an additional load application area for edge 
trusses. As load application area RX-TIMBER assumes 2 · a/2 by default, for edge trusses it as-
sumes a/2 + ü. 
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The Load Factor for Continuity k allows for increasing the resulting truss load in order to take in-
to account the influence from effects of continuity. As the influence may vary depending on 
the roof area, you can determine the factor manually and enter it into the table. 

When you tick the option Edge Beam, the program will assume the reduced load application 
area of an edge truss. 

Roof beam geometry 
This group defines the individual dimensions of the beam. The number of parameters varies 
according to the beam type. Each input value is displayed for better understanding in the 
graphic to the right. Some values depend on each other and thus are interactive: When you 
specify the Beam Length L, the Axial Spacing l changes automatically. When you enter a value 
for the Support Width Left la or Right lb, the axial spacing will be adjusted accordingly. 

 
Figure 5.11: Parameters of the Roof Beam Geometry 

The setting for adjusting parameters interactively can be deactivated or reactivated by using 
the button shown on the left. If the button [Plausibility Check] is disabled, you can enter any 
value. However, it is recommended to enable the check again when the input is complete to 
ensure a correct definition of the geometry. If the geometry is not defined within the specified 
limit values, a message appears. 

 
Figure 5.12: Plausibility check: warning in case of problems in geometry 

The message informs you about the parameters that cause problems, offering two options for 
correction: [Yes] resets the default values resulting in a coherent geometry, [No] takes you back 
to the input window so that you can correct the parameters manually. The relevant parameters 
are highlighted in color. 
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Cantilever 
This group appears only when the option Cantilevers has been selected in window 1.1. De-
pending on whether a symmetric or asymmetric beam has been specified, one group or two 
groups are displayed to define the overhang(s). 

 
Figure 5.13: Parameters of Cantilever 

A graphic is also displayed for cantilevers depending on the cantilever type, describing the 
meaning of the parameters. 

Cross-section 
This group defines the Cross-Section Width b as well as the Lamella Thickness t. The thickness t 
also affects the increment that can be defined later during the beam optimization. 

 
Figure 5,14 Parameters for Cross-section 
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Data for lateral buckling 
With settings entered in this group you decide if an analysis for safety against lateral buckling 
is performed. If you select the option Beam Endangered by Lateral Buckling, the relevant param-
eters become accessible. 

 
Figure 5.15: Parameters of Data for Lateral Buckling 

By ticking the check box for Lateral Supports Available, you can take into account additional 
lateral supports, for example in the form of purlins. Define their spacings and position in the 
subsequent table rows. 

With the value Bracing Distance e you can determine the lateral buckling moment Td on the 
support for forked supports. 

( )



 −⋅⋅−⋅= mdd k1

h
e

60
1
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1

MT   

Equation 5.1: Determination of lateral buckling moment Td according to DIN 1052: 2004-08, equation (14) 

According to EN 1995-1-1, it should be possible to absorb the following moment on the sup-
port by the forked support or a bracing. 

80/MM dd,tor =   

Equation 5.2: Moment Mtor,d according to DIN EN 1995-1-1/NA:2010-12, equation (NA.129) 

When designing the beam according to EN 1995-1-1, the program checks whether the slen-
derness for lateral buckling λef is less than or equal to 225. If the condition is not fulfilled, the 
design won't be performed. 

Attic left/right 
With the settings for Attic Left or Attic Right you can decide if you want to consider an attic on 
the roof. 

 
Figure 5.16: Parameters for Attic Left and Attic Right 
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The attic parameters affect the snow load generation: 

 
Figure 5.17: Influence of attic on the generation of snow loads 

Information parameters 
The final group is represented by the Information - Parameters including various geometrical 
data. The values cannot be modified, they are indicated only for information. The number of 
displayed values varies according to the beam type. 

 
Figure 5.18: Information - Parameters 

A graphic is displayed for each single value, describing the meaning of the corresponding 
parameter. 
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5.3 Loading 
All loads are defined in this window. In the following, the individual window sections are de-
scribed in detail. 

 
Figure 5.19: Window 1.3 Loading 

Permanent action 
The self-weight of the beam is automatically taken into account. You do not need to define it 
in particular. Please find a description on page 49 how to deactivate the default setting. 

You can use the table to define additional, permanently acting roof loads such as the roofing. 
Click into a table cell of column A to activate the [...] button shown on the left (see Figure 5.19). 
Use this button to access the material library offering predefined roof loads (see Figure 5.20). 
They are sorted by different Categories and indicated in [kN/m2] or [kN/m3] referring to the area 
or volume. To select a material, click it and use the [OK] button to take it into the table. You can 
also double click the material to import it into window 1.3. 

To access the table entries of the material library (Figure 5.20) for modification, use the [Edit] 
button shown on the left. In this way, you can adjust the description and the specific weight of 
the material currently selected. 

The final row of the material table is empty so that you can extend the database: After entering 
a new material, a new empty row is added automatically. In this way, you can extend the li-
brary by specifying any materials. 

After editing or extending the material library, close it by clicking the [OK] button to save the 
modifications. You can also use the [Apply] button shown on the left to save the adjustments. 
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Figure 5.20: Material library for permanent actions 

When you enter loads that are indicated as volume loads in the library, you have to specify 
additionally the Thickness d in table column B. 

In addition, each load can be described by a comment entered in table column D. 

Below the table the program sums up the area loads (gk,2’), converts them into a distributed 
load (gk,2) and displays them as permanent load (gk) together with the self-weight (gk,1). The 
beam's self-weight is shown as average value. However, during the calculation it is taken into 
account accurately as a variable distributed load. 

Imposed load 
The two input fields in this window section are connected with each other. For example, if you 
define the area load pk’ [kN/m2], the program converts it automatically into the corresponding 
distributed load pk [kN/m] for a truss. The conversion between both values takes into account 
the specifications defined for the Building Dimensions in window 1.2: 

• Edge beam: k)ü
2
a

('pp kk ⋅+⋅=  

• Inner beam: ka'pp kk ⋅⋅=  

Equation 5.1: Conversion of area loads into distributed loads 

You can enter the distributed load pk also directly. In this case, the input field for pk’ will display 
the corresponding value of the area load. 

Use the button shown on the left to select the imposed load according to [3] or [7] from a table 
(see Figure 5.21). 

When an imposed load is entered, the selection field for specifying the Imposed load category 
according to EN 1991-1-1 (or DIN 1052 and DIN 1055-100) is enabled. In most cases you can con-
tinue with the preset category H without modifying the setting. The category controls the ψ 
values according to [2] table A.2 or [9] table A.1.1 as well as the load duration class (LDC) ac-
cording to [1] table 4 or [7] table NA.1. 
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Figure 5.21: Dialog box Use Imposed Load According to EN 1991-1-1 

The ψ values are taken from the add-on module RF-COMBI where they can be adjusted, if nec-
essary (see Figure 11.12, page 115). For more information, see chapter 6.3 and the RF-COMBI 
manual that is available for download at www.dlubal.com. 

Service class 
The service class SECL is defined for the entire beam in the bottom left corner of window 1.3. 
Use the button shown on the left to access a selection dialog box where the individual service 
classes are shortly described. 

Snow load 
This window section manages the parameters for the automatic creation of snow load cases. 
The loads are generated according to the rules specified in EN 1991-1-3 (or DIN 1055-5). 

First, enter the Altitude above sea level in m. Then, Determine the snow load automatically or 
Define snow load manually. 

Determine automatically 

The Snow load zone SZ can be selected directly from the list or determined by a double-click in 
the snow load map (Figure 5.22). The map with the snow load zones can be opened by clicking 
the [Info] button shown on the left. 

If loads are generated according to EN 1991-1-3, the Topography type TT must be specified ad-
ditionally. The list offers three options: Windswept, Normal and Sheltered. 

Moreover, the program provides the options North German Plain, Snow load of overhang and 
Snow load on snow guard allowing together with the relevant additional settings for a specific 
load generation control. To display additional information, use the [Info] button. 

In the snow load map of Germany, the North German Plain (Norddeutsches Tiefland - see figure 
below) is indicated. When you select the corresponding option, the program creates an addi-
tional, exceptional load case with 2.3-fold snow loads. 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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Figure 5.22: Map showing snow load zones in Germany 

When you consider the Snow load of overhang, a window is available showing information 
about the equation used to determine the additional load. 

 
Figure 5.23: Dialog box Snow Load of Overhang 
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When you consider the Snow load on snow guard, you have to specify the guard's Distance aR 
from the edge of the roof. 

 
Figure 5.24: Dialog box Snow Load on Snowguard 

Below, the snow load resulting from altitude and snow load zone is displayed for information  
as area and distributed load in the inactive input fields of the option Define snow load manually. 
The snow load value is represented by the characteristic snow load sk. When generating the 
snow load using sk, the program takes the shape coefficient according to [5] clause 4.2.5 or [10] 
clause 6.3, equation (6.5) additionally into account, which is why the value displayed here can-
not directly be found later in the load representation. 

Define snow load manually 

By defining the load manually you can enter the snow load either as area load sk’ or distributed 
load sk. The respective conversion between the loads is done analogously to the determination 
of the imposed load pk (see Equation 5.1, page 42). 

The relevant shape coefficient is also taken into account for the generated loads. 

Wind load 
This window section manages the parameters for the automatic creation of wind load cases. 
The loads are generated according to the rules specified in EN 1991-1-4 (or DIN 1055-4). 

Wind loads always refer to a closed hall. Additional wind loads occurring for buildings that are 
open on one side or several sides must be entered specifically. Similar to the generation of 
snow loads, two options are available to define wind loads: You can choose between Determine 
automatically or Define manually. 

Determine automatically 

When you generate wind loads automatically, the Wind Zone WZ as well as the Terrain Category 
TC must be specified. The wind zone can be defined by double-clicking the relevant region in 
the wind zone map that you open with the [Info] button shown on the left (see figure below). 
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Figure 5.25: Wind zone map for Germany 

The wind zone sets the value of the Fundamental basic wind velocity vb,0 according to [11] 
clause 4.2. Use the [Edit] button shown on the left to adjust the values for the velocity pressure. 
The following dialog box appears: 

 
Figure 5.26: Dialog box Coefficients for Wind Load Generation according to EN 1991-1-4 

By ticking the option Body shells with permeable walls it is possible to define a µ value accord-
ing to [4] equation (19) or [11] equation (7.3) to take into account additional lifting forces due 
to permeable walls. If the beam has a cantilever, the program determines the load case "roof-
lifting internal wind" as well in accordance with the connected wall area. However, the load 
generation is not able to consider all areas and special cases according to [4] or [11] so that you 
additionally have to define, if necessary, further actions from such loads (see the following de-
scription for Show Generated Loads / Define Additional Loads). 
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Click the [Settings] button shown on the left to open a dialog box where you can define the 
parameters of the walls in detail. 

 
Figure 5.27: Dialog box Body Shells with Permeable Walls according to EN 1991-1-4 

The dimensions of the building are decisive for the wind load generation. Based on the dimen-
sions specified in window 1.2, the program determines the data fields in column F, G, H and I 
(see figure below) according to [4] or [11] for the respective beam type and generates the wind 
loads accordingly. For the zones where compressive as well as suction forces are applied, the 
program creates two load cases for each wind load case with suction or compressive forces. 

 
Figure 5.28: Wind suction in load case 51 (case AA) 
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In case of special regulations, like for the generation of snow loads, follow the lists of the tech-
nical construction regulations of your country. 

Define peak velocity pressure manually 

If you select the option Define peak velocity pressure manually, you can enter the wind load ei-
ther as area load q(z)’ or distributed load q(z). The conversion between the loads is similar to 
the calculation of the imposed load pk (see Equation 5.1, page 42). 

Show Generated Loads / Define Additional Loads 
The button [Show Generated Loads resp. Define Additional Loads] provides access to the loads 
generated with the specifications of window 1.3. The dialog box Load Cases opens. 

 
Figure 5.29: Dialog box Load Cases 

Load case 

Use the list LC No. to select the load case that you want to be shown in the dialog section Load. 
With the arrow buttons [] and [] �you can set the next or pre    

With the [New] button shown on the left you can create additional load cases. In this way, you 
can consider loads that are not generated automatically. The value of a user-defined load must 
be specified as Load Parameter in table column D. See page 50 to learn how to enter additional 
loads. 

Additional load cases can be deleted by means of the [Delete] button shown on the left. Please 
note that generated load cases can be neither deleted nor modified. 

The Short description makes it easier to keep track of the created result combinations (see chap-
ter 7.1, page 61). 

The Description helps you to specify the load. It appears also in the printout report where the 
load cases are listed. 
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For user-defined load cases you have to specify the Load Type. You can select the following op-
tions: Permanent, Variable, Accidental and Seismic. For variable loads it is possible to assign the 
Imposed Load Category like in window 1.3 as well as the Load Duration Class LDC. 

Self-weight 

By clearing the check box in the dialog section Self-weight you can deactivate the setting for 
taking into account the self-weight. It is also possible to scale the self-weight by a factor. Factor 
1.0 is set by default. 

Comment 

Each load case can be described by user-defined notes. 

Load 

Table and graphic in the dialog section below display the loads of the load case set above. 

In load case 1 "Self-Weight + Roof Finishes", the self-weight is represented graphically. The ta-
ble, however, does not display it separately. It only lists the loads that have been defined as 
roof structure (gk,2) in window 1.3. 

The values of the snow and wind load are generated with the corresponding factors. Thus, the 
graphic displays the load that is applied effectively to the beam. 

The wind load in the single load cases is generated perpendicular and parallel to the ridge di-
rection. If the roof can be stressed by suction as well as compression according to the stand-
ard, the program generates two separate load cases for the same wind direction. They are dis-
tinguished by the indications A and B. 

To display the respective explanatory graphics for illustrating the load parameters, use the 
button shown on the left. To reset the load graphic view, click the button again. 

 
Figure 5.30: Dialog box Load Cases: explanatory graphics for load parameters 

Table and graphic are interactive: When you select a load in the table, it is highlighted in the 
graphic. When you click a load in the graphic, the corresponding table row is marked. 
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Define additional loads 

Additional loads can be entered directly into the next free table row. However, it is recom-
mended to create a [New] load case to manage the cases separately. You have to define the 
descriptions, the load type and, if necessary, the service class category and the LDC. 

In table column A of the dialog section Load (see Figure 5.30) you specify the Load Type. A list 
offers the load types shown on the left for selection. When the display with explanatory 
graphics is set, pictures appear in the bottom dialog section illustrating the individual param-
eters for load definition. Depending on the selected load type, other table columns become 
active or inactive in the table row. 

When you define the Load Direction, three different settings are available: The loads can be de-
fined in relation to the local member axes, in direction of the global axes on the effective 
length or in direction of the global axes on the projected length. The graphic in the bottom di-
alog section may help you to find the appropriate selection. 

Further, you have to define the Load Reference, specifying the part of the beam where you 
want to apply the load. In order to simplify the input for structural beam parts, the following 
options are provided: whole beam, inner span, left/right span side, cantilever left/right. The 
Cantilever options are only available if an appropriate beam geometry has been set. 

To arrange loads on any structural part of a beam, line loads must be defined as trapezoidal 
loads and line moments as trapezoidal moments. Only for these load types it is possible to de-
fine the start and end points of the load freely. It is recommended to always activate the graph-
ic of loads so that you can check the input. 

In table columns D to I, you can enter the loads according to the selected load type. For trape-
zoidal loads you can use the option Across Total Length to apply the load to the entire beam. 
Alternatively, you have to define the start and end points (A and B) of the load as well as the 
corresponding load values p1 and p2. 

The button shown on the left allows for switching the load values on and off in the load graph-
ic. 

Particular graphic parts can be checked specifically by using the zoom function: Click into the 
graphic and then use the wheel button to minimize or maximize the graphic view. 

The wheel button of the mouse can also be used for rotating the beam: Hold down the wheel 
button to move the structure anywhere in the graphic window. Now press the [Ctrl] key addi-
tionally to display the beam in the isometric view. 

To reset the original graphic view, click the button [Show All Graphic] shown on the left. 

When the input is complete, close the Load Cases dialog box by clicking the [OK] button to 
save the modifications. When you click [Cancel], you quit the dialog box but without saving 
the modifications. All modifications entered since the dialog box has been opened will be lost. 

RF-COMBI 
With the [RF-COMBI] button you can access the add-on module RF-COMBI that is used to com-
bine load cases according to [2] or [9]. Usually, it is not required to modify data in RF-COMBI 
because the creation of combinations is performed automatically in the background also for 
user-defined loads. Therefore, you may use the button to understand the generation of com-
binations. 

For more information on the features of RF-COMBI, see the manual available for download at 
www.dlubal.com. 

 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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5.4 Control Parameters 
Program window 1.4 Control Parameters allows for numerous settings to control the calculation. 

 
Figure 5.31: Window 1.4 Control Parameters 

Design of 
This window section sets the designs that are performed. The Ultimate limit state and the Ser-
viceability limit state design are preset. 

For the serviceability limit state design you can take into account an assumed Precamber of the 
beam by specifying a value for wc or w0. In addition, you have the option to not consider canti-
levers for the analysis. 

When you tick the option Fire protection, you can access the parameters for the fire protection 
design. To define the fire duration, select one of the fire resistance classes (R 30, R 60, R 90), or 
specify it by user-defined input. In the image below, you can define the beam sides for which 
you want to consider Charring. 

Support modelling 
Set the beam's support conditions. A successful calculation requires that the support is either 
defined as Horizontal fixed on at least one side or restrained by a bending-resistant column by 
selecting the Column option. 

The supports are applied eccentrically by default. In this way, the wall-like structural behavior 
of beams which are often high and slender is taken into account. With the option Supports on 
center line, it is possible to shift the supports to the centroidal axis of the member (see picture 
in the margin) to reduce or eliminate the high boundary moments due to a compression force. 

To specify the column parameters, use the [Edit] button shown on the left. The following dia-
log box opens. 



5  Input 

 

 

52 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

 

 
Figure 5.32: Dialog box Edit Column to determine support springs 

In the dialog section Column Type, the options Rectangular and Circular are available for direct 
geometry input. The parameters are represented in the small graphic to the right. In case of 
special column cross-sections, use the option Cross-section from library that allows you access 
to a comprehensive cross-section database. 

The settings for Column height and Material as well as Support conditions in the dialog section 
Parameters affect the support spring determination considerably. The column base setting of-
fers three options whereas the setting for the column head allows only for a hinged connection 
or a partial restraint: The spring stiffness on the support is determined from the beam's point 
of view. As the column cannot provide a complete restraint, the program applies the rotational 
spring stiffness of the defined column for the option Partial rigid. 

Based on the specified values, the program determines the spring stiffnesses in direction X and 
Z that will be used later as support conditions for the calculation. The dialog section Support 
Springs Due to Column shows the calculated spring values.  

If you select the option As left column in window 1.4 (Figure 5.31), the program defines the col-
umn also for the right support. The values of the left column are preset in the dialog box Edit 
Column and can be adjusted, if necessary. 

Optimization 
With the settings in this window section you decide if and how the program Performs an opti-
mization for the beam cross-section. The cross-section can be optimized by different criteria: 
Corresponding to the beam type you can adjust the Beam Height, the Shape or the Cross-Section 
Width. 

The target of the optimization is preset with the Maximum ratio of 100 %. If necessary, you can 
specify another upper limit in this input field. 

When optimizing the Beam Height you need to define the upper and lower limit for the height 
in the support center. When optimizing the Shape several boundary conditions can be defined 
(depth of beam in support center and on ridge, radius of curvature, inclination of lower chord 
etc.). The fewer parameters are set, the faster the beam will be optimized. 

The Cross-Section Width can be optimized within user-defined limit values. The lamella thick-
ness selected in window 1.2 is preset as Increment that you can adjust, if necessary. The proce-
dure varies depending on the beam type. 
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The Spacing of Lateral Supports is important for the lateral buckling design. For beams prone to 
instability risks you can optimize the spacing within particular limits and a user-defined incre-
ment to fulfill the requirements of the design. 

To display 
By ticking the check boxes you decide if Support forces, Deformations and Support compression 
will appear in separate results windows. When designing the beam according to DIN 1052: 
2008-12, an Oscillation design is possible. 

The number of results windows appearing in the output depends on the design and output 
data that you select in this window section. 

Calculation parameters 
Settings in this window section affect the number of generated result combinations as well as 
the calculation accuracy. 

With the option Generate supplementary combinations from favorable permanent actions the 
program is able to distinguish favorable and unfavorable permanent actions and to take them 
into account with different partial safety factors. Necessarily, the number of generated combi-
nations will be increased in the output. 

The Number of member divisions for Result diagrams determines how much x-locations are set 
on the longest member in the system. This division length will be valid also for the x-locations 
of all other members in the model. The x-locations represent the locations on the beam where 
designs are performed. The preset division value 10 for result diagrams has proven to be a 
good compromise between computational accuracy and speed. 

 
Figure 5.33: Principle of member divisions for result diagrams 

To get a sufficient set of values for the calculation of Tapered members which are usually rela-
tively short, it is possible to define the internal division for tapers specifically. The division val-
ue is also preset with 10. This setting does not result in an increased number of output results 
but only in a reduction of the division length for the internal calculation of the internal forces. 



6  Calculation 

 

 

54 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

 

6. Calculation 
To start the calculation, use the [Calculation] button that is available in each input window. 
The designs are performed with the result combinations generated in RF-COMBI. Before you 
start the calculation, it is recommended to check the settings concerning calculation details 
and selected standard. 

6.1 Calculation Details 
To check important design parameters, use the [Details] button to open the dialog box below 
that can be accessed from any window in the program. The dialog box is aligned with the stan-
dard or the selected national annex. Figure 6.1 shows the Details dialog box for EN 1995-1-1 
with the national annex for Germany. 

 
Figure 6.1: Dialog box Details according to DIN EN 1995-1-1 for RX-TIMBER Glued-Laminated Beam 

Maximum Cut-to-Grain Angle 
EN 1995-1-1 specifies no limitation for the cut-to-grain angle. The German standard DIN 1052, 
however, restricts the angle to 10° as the standard's equations are only valid for angles of up to 
10°. In this dialog section, you can define the limit value yourself. The presetting in RX-TIMBER 
is 20°. 

Torsion moments on supports 
The torsion design on the supports according to [7], NAD for Germany, has been considerably 
eased: The design is to be performed only if the slenderness is larger than 225. RX-TIMBER 
checks this condition automatically. 

For the design according to DIN 1052 it is additionally possible to apply the lateral loads of the 
trusses as stabilizing loads (see explanations for DIN 1052). 

When the torsion moment Td has been determined manually, it can be entered directly. The 
moment will be applied as cosine function descending from the supports. 

Special settings for timber 
When compact beams are used (height h < 600 mm), many design standards allow you to in-
crease the strength values of the material. In case of glued laminated timber it is assumed that 
the material's weakening is not that strong due to the finger joint. 
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When the check box for Reclassify combined glued laminated timber in the beam span into ho-
mogeneous is ticked, the program checks for each design location if the conditions for com-
bined glued laminated timber are geometrically fulfilled. If the higher strength of 1/6 in both 
boundary areas at top and bottom is not given, RX-TIMBER will automatically select the next 
lower strength grade and display a corresponding message. Then, you can either select a 
higher material grade in the critical areas or perform the design with reduced strengths. 

Reduction of internal forces 
Use the options in this dialog section to reduce moments and shear forces in the support area. 
The reduction of the supporting moment by a Moment reduction is only possible if your beam 
is a multi-span or a cantilevered beam. 

As EN 1995-1-1 allows only for the reduction of concentrated loads in the support area, the op-
tion for reducing shear forces is not displayed for distributed loads. The request for a complete 
reduction of the concentrated loads cannot be answered by RX-TIMBER because a separate 
calculation of internal forces would be required. 

The following figure shows the Details dialog box of the program RX-TIMBER Continuous Beam 
for the design according to DIN 1052. 

 
Figure 6.2: Dialog box Details according to DIN 1052 for RX-TIMBER Continuous Beam 

In the dialog section Special Settings for Timber you can decide to define the Grain parallel to 
the bottom edge of the beam. The remaining setting options refer to specifications in the Ger-
man standard DIN 1052. They correspond to the options represented in Figure 6.1. 
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6.2 Standard and National Annex 
The button [National Annex] shown on the left provides access to significant design parame-
ters such as the partial safety and modification factors as well as the limit values of the defor-
mations. The dialog box is aligned with the standard or the selected national annex. The fol-
lowing figure shows the parameters for EN 1995-1-1 with the national annex for Germany. 

The dialog box National Annex Settings consists of three tabs. 

6.2.1 General Parameters 

 
Figure 6.3: Dialog box National Annex Settings, tab General 

Partial factor 
In this dialog section you can check and, if necessary, adjust the partial safety factors of the 
material stiffnesses for the different design situations. The factors are preset according to the 
specifications of the standard selected in program window 1.1 Beam Type and Material. 

Limit values of deformations 
The deformation's limit values can be adjusted individually for the serviceability limit state de-
sign so that it is possible to perform the design according to specifications of different guide-
lines. 

The allowable deflections can be defined separately for the individual design situations and 
boundary conditions (span, cantilever). 



6  Calculation 

 

 

57 Program RX-TIMBER © 2013 Dlubal Software GmbH 

Modification factor kmod 
To take into account the moisture-dependent long-term effects of timber, it is possible to ad-
just the modification factors. They depend on the service and the load-duration class. The cal-
culation values of the modification factors are specified in [1] table F.1 and [7] table 3.1. 

Data for fire protection 
The designs are carried out by the simplified method according to [6] clause 5.5.2.1 a) or [8] 
clause 2.3, 3.4.2 and 4.2.2. The preset values for βn, d0 and kfi are valid for glued laminated tim-
ber. Thus, it is usually not necessary to modify them. 

6.2.2 Other Parameters 

 
Figure 6.4: Dialog box National Annex Settings, tab Other 

Partial factor for stiffenings for transversal tension 
This dialog section controls the partial safety factors that must be taken into account for the 
different types of transversal tension stiffenings (see chapter 5.1, page 32). 

The program presets the partial safety factors for material properties and load capacity rec-
ommended in the standard (for example EN 1995-1-1, table 2.3). 

Shear factor 
For shearing stresses along and perpendicular to the grain direction you must observe specific 
conditions according to EN 1995-1-1, clause 6.1.7. 

The factor kcr can be User-defined for solid and glued-laminated timber. Many countries still do 
not provide uniform material standards managing this stiffness. 
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Volume factor 
When designing glued-laminated beams you can adjust the volume factor kvol for solid and 
glued-laminated timber. You find the relevant standard specifications in EN 1995-1-1, clause 
6.4.3 (6). 

Factor of compression perpendicular to grain  
For the design of the support compression the compression strength is adjusted perpendicu-
lar to the grain direction by means of the factor kc,90 (see EN 1995-1-1, clause 6.1.5). With the 
default setting according to standard specifications RX-TIMBER increases the strength corre-
sponding to the material type and the load situation. However, as it is usual in some countries 
to calculate generally with a strength increase of 75 %, the factor can be user-defined. 

Click the [Info] button shown on the left to get more information on the factor determination. 

 
Figure 6.5: Dialog box Factor of Compression Perpendicular to Grain 

Factor of stress distribution 
For glued-laminated beams you can adjust the factor kdis used to consider the stress distribution 
in the ridge zone. You find the relevant standard specifications in EN 1995-1-1, clause 6.4.3 (6) as 
well as in the national annexes. 

6.2.3 Standards Used 
The final tab lists all rules and standards that are relevant for the generation of loads and the 
design according to the selected standard. 
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6.3 RF-COMBI 
The add-on module RF-COMBI is integrated in RX-TIMBER. It generates all result combinations 
automatically. Use the [RF-COMBI] button to start the add-on module. 

 
Figure 6.6: RF-COMBI window 1.1 General Data 

To avoid generating an unnecessary high number of result combinations, it is recommended 
to Reduce possible result combinations in the window section Supplementary Examination of 
window 1.1 General Data. In this way, you make sure that the results of RF-COMBI include all 
governing result combinations but without generating more load cases than necessary. 

Find more information about the add-on module RF-COMBI in the program manual available 
for download at www.dlubal.com.  

After the [Calculation] you can check the results of the combinatorics: The generated result 
combinations are presented in three results windows sorted by different criteria. 

 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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Figure 6.7: RF-COMBI window 2.2 Result Combinations 

Click [OK] to return to the program RX-TIMBER. 

6.4 Calculation 
To start the calculation, click the [Calculation] button that is available in all input windows of 
RX-TIMBER. During the calculation the FE-Solver window is displayed, showing information 
about the calculation process. 

 
Figure 6.8: Window FE-Calculation 

The results window 2.1 Result Combinations appears immediately after the calculation (see 
Figure 7.1). 
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7. Results 
The designs are shown in the results windows 2.1 to 2.3 and sorted by different criteria. Win-
dows 2.4 and 2.5 lists the support forces and deformations. 

You can select every window by clicking the corresponding entry in the navigator. You can al-
so use the buttons shown on the left to set the previous or next window. Alternatively, you can 
press the function keys [F2] and [F3]. 

To save the results and exit RX-TIMBER, click [OK]. 

Chapter 7 Results presents the results windows in sequence. 

7.1 Result Combinations 
This window shows the maximum design ratios for each single result combination. Table col-
umn RC Description lists the combinations with the short descriptions of the contained load 
cases (see page 48: Short description). Column B Load Cases displays the combination criterion 
with load case number and considered factors from RF-COMBI. 

 
Figure 7.1: Window 2.1 Result Combinations 

Table column C Design Situation informs you about the design situation to which the combina-
tion belongs. RX-TIMBER distinguishes the following situations: 

UB Fundamental combination for bearing capacity 

UA Accidental combination for bearing capacity 

S1 Basic combination 1 for serviceability 

S2 Basic combination 2 for serviceability 

SQ Quasi-permanent combination for serviceability 

Table 7.1: Design situations in RX-TIMBER 
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Table columns D LDC and E Factor kmod list the load-duration classes and the modification fac-
tors. 

The final column F Max. Design indicates the maximum design ratio for each result combina-
tion. The ratios are represented by colored scales: For designs ≤ 1 a green scale is displayed, for 
designs > 1 a red scale appears. The color scales can be deactivated, if necessary, by means of 
the button shown on the left. 

Filter functions 
The results are arranged in blocks: The ultimate limit state design is displayed first, followed by 
the serviceability limit state design and the fire protection check. Below the table you find 
three buttons that can be used for filtering the design results in the list. 

 
Figure 7.2: Window 2.1 Result Combinations with filter set only for serviceability limit state design 

The buttons have the following functions: 

Button Function 

 
Hides and displays the ultimate limit state design 

 
Hides and displays the serviceability limit state design 

 
Hides and displays the fire protection design 

Table 7.2: Buttons for designs 

If designs with a ratio of > 1 are available, an additional filter function is enabled: Click the but-
ton shown on the left to hide all designs ≤ 1. In this way, you can check all failed designs at a 
glance. 
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7.2 Design - All  
The second results window presents an overview about all performed designs. The upper part 
of the window shows a table with the maximum design ratio for each type of design. This over-
view allows you to quickly evaluate the maximum design ratios for the individual designs 
(shear stress, bending stress, lateral buckling analysis, support pressure etc.). 

The lower part of the window displays the Intermediate results for the load case set above. They 
provide detailed information about cross-section and design internal forces as well as design 
parameters including notes for tables and equations of the standard. 

 
Figure 7.3: Window 2.2 Design - All 

Location X 
The first table column shows the respective X-location on the member for which the program 
has determined the maximum design criterion. The following member locations X are taken 
into account for the table output: 

• Start and end node 

• Division points according to member divisions defined in window 1.4 Control Parameters 
(see chapter 5.4, page 53) 

• Extreme values of internal forces 

RC 
Table column B displays the numbers of the result combinations whose internal forces result in 
the respective maximum ratios. 

Ratio 
The program shows for each design type the design ratios according to the selected standard. 
The colored scales represent the corresponding ratio. 

Design according to formula 
The final table column lists the equations according to EN 1995-1-1 (or DIN 1052) that were 
used to carry out the design. 
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7.3 Design by X-Location 
The structure of the results window is similar to the one of window 2.2 described in the previ-
ous chapter. The table lists in detail the results for each analyzed Location X on the beam. 

The results are summarized in groups sorted by bearing capacity, serviceability and fire protec-
tion. Use the buttons shown on the left to filter the design types (see chapter 7.1, page 62). 

 
Figure 7.4: Window 2.3 Design by X-Location 

Due to the variety of loads it is not possible to clearly identify the decisive beam location im-
mediately. Therefore, the beam is analyzed at different design locations X: 

• Start and end node 

• Division points according to member divisions defined in window 1.4 Control Parameters 
(see chapter 5.4, page 53) 

• Extreme values of internal forces 

The results windows generally display the Locations X. They are related to the global coordinate 
system and represent the length X projected to the floor plan. In contrast, the result diagrams 
(see chapter 7.6, page 67) refer to the local member axis x where the length x of the inclined 
beam is indicated. 
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7.4 Support Forces 
The window lists the support forces of the individual load cases and result combinations. The 
extreme values of the result combinations are summarized in groups sorted by bearing capaci-
ty, serviceability and fire protection. 

 
Figure 7.5: Window 2.4 Support Forces 

Support forces for load cases are displayed as characteristic loads. Thus, it is possible to use 
them for other calculations. Support forces for result combinations are displayed considering 
the design loads. 

The following values are additionally displayed below the table: 

• Td  Tilting moment for pinned support according to [1] eq. (14) or [7] (NA.129) 

• Nd Axial force in compression edge according to [1] eq. (15) or [7] eq. (9.36) 

• q Equivalent load for 1 beam according to [1] eq. (16) ) or [7] eq. (9.37) 

However, the indicated values are not taken into account for the design. 
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7.5 Deformations 
The final results window lists the maximum deformations for the individual load cases and re-
sult combinations. 

 
Figure 7.6: Window 2.5 Deformations with oscillation check according to DIN 1052 

The window shows the displacements on each Support uz and ux as well as the Maximum Span 
Deflection max uz at the governing X-locations. 

If the model has cantilevers, the table is extended by the Cantilever column showing the dis-
placements uZ,c. 

The right part of the table provides information about the Rotations φ on the supports and, if 
available, the cantilevers. 

When the oscillation design according to [1] paragraph 9.3 (1) was selected in window 1.4 (see 
chapter 5.4, page 53), you can find the design result listed below the table in window 2.5. 
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7.6 Result Diagrams 
The distribution of results on a beam can be evaluated graphically in the result diagram. To ac-
cess the diagram, use the button shown on the left which is available in each results window. 

A new window opens displaying a navigator and the beam's result diagrams. 

 
Figure 7.7: Dialog box Result Diagram on Member 

Use the navigator on the left to select the deformations and internal forces that you want to 
display in the result diagram. Use the list in the toolbar to choose a particular load case, result 
combination or RX-TIMBER design case. 

A dotted line in the result diagram of the RX-TIMBER design indicates the design ratio of 1.0 
(see Figure 8.12, page 75). In this way, you can evaluate the significance of the results quickly. 

With the navigator entry Result Combinations you have the possibility to display Original or 
Modified internal forces that are used for the design because of a moment or shear force re-
duction. It is also possible to display Both internal forces. 

The results windows of RX-TIMBER show the global X-locations where the designs are per-
formed, but the result diagrams refer to the local member axis x. However, the relation be-
tween global and local locations is ensured: When you have selected a (global) location X in  
a table and you open the result diagram, the position line jumps automatically to the corre-
sponding (local) location x in the diagram. 

The result diagrams can be either printed directly by using the print function or transferred in-
to the printout report (see chapter 8.4, page 75). 

For more detailed information about the dialog box Result Diagram on Member, see chapter 9.5 
of the RFEM manual that is available for download at www.dlubal.com 

 

http://www.dlubal.com/manuals-for-category-finite-elements.aspx
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8. Printout 
The input and output data of RX-TIMBER is not automatically sent to a printer. Instead, a so-
called printout report is generated first to which you can add graphics, explanations, scans and 
other elements. In the printout report you define the data that will finally appear in the printout. 

A printout report can only be called up if a default printer has been installed in Windows. The 
preview in the printout report uses that printer driver. 

8.1 Printout Report 
To open the printout report, use the button shown on the left. 

 
Figure 8.1: Printout report 

If required, you can rename the printout report. To open the corresponding dialog box, 

select Rename on the File menu of the printout report. 

 
Figure 8.2: Dialog box Rename Printout Report 
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When the printout report is open, you see the report navigator on the left. On the right, the 
page view with the preview of the printout is presented. 

The individual chapters of the report can be shifted anywhere in the navigator by using the 
drag-and-drop function. 

Context menu 
The context menu offers more options for adjusting the printout report. As common for Win-
dows applications, multiple selections are possible by using the [Ctrl] and [] keys. 

 
Figure 8.3: Context menu of report navigator 

Remove from printout report 

The selected chapter is deleted. If you want to reinsert it, use the selection: Click Selection on 
the Edit menu to open a dialog box where you can choose data for the printout report. 

Start with new page 

The selected chapter starts on a new page. It is marked by a red pin in the navigator (like chap-
ter Results - Summary shown in the figure above). 

Selection 

You have access to the global selection that is described on the following pages. The selected 
chapter is preset. 

Properties 

Some general properties of the selected chapter can be modified. 

 
Figure 8.4: Dialog box Properties 
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Navigation in the printout report 
To look at a particular paragraph in the printout report, click the corresponding chapter entry 
in the navigator. 

The Zoom entry on the View menu as well as the Edit menu offer more functions for naviga-
tion. You can also use the buttons in the report toolbar to access the corresponding function. 

   Go to previous page in the page preview 

   Go to next page 

   Go to first page in the page preview 

   Go to last page 

   Specify the number of a particular page in a dialog box. 

   Zoom in 

   Zoom out 

 List button for Zoom to adjust display size 

 Grab mode: Use the mouse for navigation within the report. 

 Selection mode: Select and edit chapters by mouse click. 

Table 8.1: Navigation buttons in the toolbar 
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8.2 Selection of Printing Data 
In the global selection, you can select the chapters that you want to appear in the printout re-
port. To access the corresponding function, 

select Selection on the Edit menu of the printout report 

or use the toolbar button shown on the left. You can also use the context menu of the naviga-
tor item Contents. 

The following dialog box appears: 

 
Figure 8.5: Dialog box Printout Report Selection, tab Global Selection 

Global selection 
The Global Selection tab manages the main chapters of the report. If you clear a check box, the 
corresponding detail tab disappears as well. 

The Display section in the left corner of the dialog box provides three check boxes. Tick the 
check boxes to include a Cover sheet, the Contents or small Info pictures in the report margin. 

Input data / results 
With the Input Data and Results tabs you can set the printout's data amount. The designs per-
formed for a beam may vary from a few pages to an amount of more than 150 pages. There-
fore, a useful selection of output data is important. The design details are often very extensive, 
especially for the results sorted by X-location. 

The data in the printout reflects the data arrangement in the program's in- and output. 

Each selection is documented in the report navigator where it can also be removed. 

 



8  Printout 

 

 

72 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 
Figure 8.6: Dialog box Printout Report Selection, tab Input Data 

Similar to the filter function of the results windows, the Results tab provides a Filter function for 
the ultimate limit state, the serviceability limit state and the fire protection design. 

 
Figure 8.7: Dialog box Printout Report Selection, tab Results 
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8.3 Printout Report Header 
A printout report header is created based on customer data during the program installation. 
To change this data, 

select Header on the Settings menu of the printout report 

or use the toolbar button shown on the left. 

 

Figure 8.8: Button Header Setup 

The following dialog box appears: 

 
Figure 8.9: Dialog box Printout Report Header 

In the dialog section Display, you select the elements that should be shown in general. In addi-
tion, it is possible to define Date settings. 

The option Info row below header activates and deactivates the display of project and model 
data, with or without Date. The project description is taken from the project's general data 
filed in the Project Manager (see chapter 4.1.1, page 14). The model description is taken from 
the base data of the model (see chapter 4.2, page 26). It is possible to adjust the presettings in 
the dialog sections Change Project Name/Description and Change Model Name/Description. 

The Footer can be switched on and off as well as the Black circles in the points of intersection of 
the boundary line with header and footer line. 
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The numbering can be adjusted in the dialog section Page and Sheet Numbering. If Page and 
Sheet have the same initial numbers and the Display check boxes are ticked, there is no differ-
ence in numbering. But if you want to assign several pages to a sheet, it is possible to enter de-
tailed specifications for the numbering by means of the [Settings] button shown on the left. 

 
Figure 8.10: Dialog box Page and Sheet Numbering 

The dialog section Company Address in the dialog box Printout Report Header (see Figure 8.9) 
contains information from customer data that can be adjusted. A separate input field is availa-
ble for each of the three rows of the report header. Use the [A] button shown on the left to 
change font and font size. The Alignment of rows can also be defined separately. 

The left area of the header is reserved for the company logo. The image must be available as 
bitmap file format (MS Paint for example saves graphics in *.bmp format). 

To save the modified settings, click the button [Set Header as default] in the bottom left corner 
of the dialog box. The dialog box Header Template Name opens where you have to enter a de-
scription. Then, the new report header will appear as Header Default on the top of the printout. 

Use the dialog button [Header Library] to access different printout report headers. In the Head-
er Library you can create templates or modify and delete available headers. 

 
Figure 8.11: Dialog box Header Library 
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The headers are usually stored in the file DlubalProtocolConfig.cfg that you find in the gen-
eral master data folder C:\ProgramData\Dlubal\Stammdat. The file won’t be overwritten during 
an update. Nevertheless, saving a backup file may be useful. 

8.4 Result Diagrams 
The printout report can be completed by graphics of the result diagrams (see chapter 7.6, page 
67). First, set the corresponding result diagrams in RX-TIMBER by means of the button shown 
on the left. 

Use the [Print] button to print the current graphic into the printout report. 

 
Figure 8.12: Button Print in the toolbar of the window Result Diagram on Member 

The following dialog box appears: 

 
Figure 8.13: Dialog box Graphic Printout, tab General 

Graphic picture 
In the dialog section Graphic Picture, select the option To a printout report. 
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The dialog sections Window To Print and Graphic Size are irrelevant for the result diagrams of 
RX-TIMBER (they represent settings for RFEM graphics). 

Graphic picture size and rotation 
Settings in this dialog section define the size of the graphic on the sheet. 

If the check box for Use whole page width is ticked, the left margin beyond the vertical separa-
tion line is additionally used for the graphic. 

If you don't want to use the complete page size for the graphic, you can define the Height of 
the graphic area in percentage. 

The rotation angle in the input field Rotation rotates the graphic for the printout. 

Options 
When you move the mouse along the member set in the result diagram, you can see the "mov-
ing" result values for the current x-location. Use the check box Show results for selected x-location 
in result diagram to decide if values displayed on the position of the vertical line appear in the 
printout of the result diagram. 

The program generates dynamic graphics by default: When the model is modified, the graphics 
in the printout report will be updated automatically. To disable the update function, use the 
check box Lock graphic picture. 

You can unlock the graphic in the printout report: Right-click the graphic item in the report 
navigator to open its context menu (see Figure 8.3, page 69). Select Properties to access again 
the dialog box Graphic Printout for the picture. You can also mark the graphic in the report 
navigator and select Properties on the Edit menu. 

The lock buttons in the toolbar of the printout report provide more functions to classify graph-
ics as static or dynamic (see Figure 8.1, page 68). The buttons have the following functions: 

 
Refreshes all graphics 

 
Unlocks all graphics which can then be updated dynamically 

 
Locks all graphics which are then fixed in the printout report 

Table 8.2: Graphic buttons in the printout report 

When you click the [OK] button in the Graphic Printout dialog box, the printout report usually 
opens. This may be annoying, for example when you want to print several graphics one after 
the other into the report. To prevent the report from being opened, clear the check box Show 
printout report on [OK] in the dialog section Options. 

Header of graphic picture 
When the dialog box Graphic Printout opens, a title with a list of member numbers is preset for 
the graphic. It can be adjusted in the input field. 
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8.5 Graphics and Texts 
It is also possible to integrate external graphics and texts into the printout report. 

Inserting graphics 
To insert a picture that is not a graphic of the RX-TIMBER program, you need to open the 
graphic file in an image editor first (for example MS Paint). Then, copy it to the clipboard  
with the keyboard keys [Ctrl]+[C]. 

To insert the graphic from the clipboard into the printout report, 

select Image from Clipboard on the Insert menu of the printout report. 

You have to enter a chapter name for the new graphic before it is inserted. 

 
Figure 8.14: Dialog box Insert image from the Clipboard 

The graphic will appear as a single chapter in the printout report. 

Inserting texts 
Short user-defined notes can also be added to the printout report. To open the corresponding 
dialog box, 

select Text Block on the Insert menu of the printout report. 

 
Figure 8.15: Dialog box Import Text 

Enter the Title and the Text in the dialog box. After clicking [OK] the chapter will be inserted at 
the end of the printout report. Then, you can use the drag-and-drop function to move the 
chapter to an appropriate place in the printout report. 

In the selection mode (see Table 8.1, page 70) you can modify the text subsequently by double-
click. Alternatively, right-click the header in the report navigator, and then select Properties in 
the context menu. 
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Inserting RTF and text files 
It is possible to integrate text files available in ASCII format as well as formatted RTF files in-
cluding embedded graphics into the printout report. Thus, you can save recurring texts in files 
to use them in the report. 

Moreover, this function allows you to integrate analysis data from other design programs into 
the printout report, provided that the results are available in ASCII or RTF format. 

To insert text and RTF files, 

select Text File on the Insert menu of the printout report. 

First, the Windows dialog box Open appears where you can select the file. After clicking the 
[Open] button, the chapter will be added to the end of the printout report. Then, you can use 
the drag-and-drop function to move the chapter to an appropriate place in the printout re-
port. 

In the selection mode (see Table 8.1, page 70) you can modify the text (of .txt files) subse-
quently by right-click. The dialog box Import Text appears for user-defined adjustments. 

 
Figure 8.16: Dialog box Import Text 
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8.6 Printout Report Template 
The selection described in chapter 8.2 is rather time-consuming. It is possible to save such a se-
lection including graphics as template which you can use also for other models. Creating print-
out reports becomes more efficient on the basis of templates. 

An existing printout report can be saved as template, too. 

Create a new template 
To define a new template, 

point to Printout Report Template on the Settings menu of the printout report, and 
then select New or 

point to Printout Report Template on the Settings menu of the printout report, and 
then select New from Current Printout Report. 

New 

First, the selection dialog box described in chapter 8.2 opens. 

Use the tabs to select the chapters that you want to print. When the selection is complete, click 
[OK] and enter a Description for the new report template. 

 
Figure 8.17: Dialog box New Printout Report Template 

New from current printout report 

The selection of the currently shown printout report is used for the new template. Enter the 
Description of the new report template in the dialog box (see Figure 8.17). 

Apply a template 
When a printout report is already open, you can apply the selected contents of a template to 
the current report. To open the corresponding dialog box, 

point to Printout Report Template on the Settings menu of the printout report, and 
then click Select. 

A dialog box opens where you can select the template from the list Available Printout Report 
Templates. 

 
Figure 8.18: Dialog box Printout Report Template 
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Details to the buttons in this dialog box can be found in Table 8.3 below. 

After confirming the dialog box and the subsequent security query, the current selection will 
be overwritten by the template. 

Managing templates 
All templates are managed in the dialog box Printout Report Template. To open the dialog box, 

point to Printout Report Template on the Settings menu of the printout report, and 
then click Select. 

The dialog box shown in Figure 8.18 appears. The functions of the buttons are enabled only for 
user-defined templates. 

 
The name of the selected template can be changed. 

 
The selected template will be deleted. 

Table 8.3: Buttons in the dialog box Printout Report Template 

The printout report templates are stored in the file RfemProtocolConfig.cfg that can be 
found in the master data folder for RX-TIMBER (C:\ProgramData\Dlubal\RX-TIMBER 2\General 
Data). The file won’t be overwritten during an update. Nevertheless, saving a backup file may 
be useful. 

8.7 Presentation 

8.7.1 Layout 
The layout of a printout report can be adjusted concerning its fonts and font colors, margin 
settings and table design. 

To open the dialog box where you can edit the page layout, 

select Page on the Settings menu of the printout report or 

use the toolbar button in the printout report shown on the left. 

 
Figure 8.19: Dialog box Page Setup 

The default fonts for table contents and table headers are relatively small. However, you should 
be careful with changing the Arial default settings. Larger fonts do not always fit in the columns 
and entries will be cut. 
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8.7.2 Cover 
The printout report can be provided with a cover sheet. To open the dialog box where you can 
enter the cover data, 

select Cover on the Settings menu of the printout report or 

use the toolbar button in the printout report shown on the left. 

 
Figure 8.20: Dialog box Cover Sheet 

When the input is complete, click [OK] to create the cover in the report. 

 
Figure 8.21: Cover sheet in the printout report 
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The contents of the cover sheet can be remodified in the selection mode (see Table 8.1, page 
70) by a double-click. Alternatively, right-click the cover sheet in the report navigator and se-
lect Properties in the context menu. 

8.7.3 Language 
The language in the printout report can be set independently of the language applied for the 
RX-TIMBER user interface (see chapter 9.2, page 88). Therefore, you can create a German or  
Italian printout report though you are working with the English program version of RX-TIMBER. 

Changing the language for printout 
To change the language used in the printout report, 

select Language on the Settings menu of the printout report. 

A dialog box opens where you can select the report language from the list. 

 
Figure 8.22: Dialog box Languages 

Adding a language to the list 
The expressions used in the printout report are stored in strings. Thus, adding new languages 
is rather easy. 

First, open the dialog box Languages by 

selecting Language on the Settings menu of the printout report. 

In the lower part of the dialog box (Figure 8.22), you see some buttons used to manage the 
languages. 

Create a new language 

Click the button shown on the left to open a dialog box. Enter the Name of the new language 
and select the Language group from the list so that the character set is interpreted correctly. 

 
Figure 8.23: Dialog box Create New Language 
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Click [OK] to confirm the dialog box. The new language is now available in the list Existing 
Languages. 

 
Figure 8.24: Dialog box Languages, button Edit Selected Language 

Use the [Edit] button to enter the strings of the new language. 

 
Figure 8.25: Dialog box Edit Printout Report Texts 

Only user-defined languages can be edited. 
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Copy a language 

 
Figure 8.26: Dialog box Languages, button Create New Language via Copy 

This function is similar to the creation of a new language. The difference is that you do not 
create an "empty" language column (see Figure 8.25, column Danish) since the terms of the 
selected language are already preset. 

Rename or delete a language 

Use the remaining buttons of the Languages dialog box to rename or delete a language. The 
two functions cannot be accessed for the preset default languages but only for user-defined 
languages. 
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8.8 Printout 

8.8.1 Direct Printing 
To start the printing process, 

select Print on the File menu of the printout report 

or use the toolbar button shown on the left. 

 
Figure 8.27: Button Print Printout Report 

The dialog box for the printer set by default in Windows opens. Select the printer and deter-
mine the pages that you want to print. 

 
Figure 8.28: Dialog box Print 

If you choose another printer than the default printer, the page break and therefore the page 
numbers printed on the paper might be different from the print preview in RX-TIMBER. 

When you select the option Print to file, you can create a print file in PRN format that can be 
sent to the printer via the copy command. 

8.8.2 Export 
The printout report can be exported in different file formats. It is also possible to export it 
directly to VCmaster. 

RTF export 
All common word processing programs support the RTF file format. To export the printout 
report including graphics as RTF document, 

select Export to RTF on the File menu of the printout report. 
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The Windows dialog box Save As opens. 

 
Figure 8.29: Dialog box Save As 

Enter the storage location and the file name. If you tick the check box for Export selected blocks 
only, only the chapter(s) previously selected in the navigator will be exported instead of the 
entire report. 

PDF export 
The integrated PDF printer makes it possible to put out report data in a PDF file. To open the 
corresponding dialog box, 

select Export to PDF on the File menu of the printout report. 

The Windows dialog box Save As opens (see Figure 8.29Figure 8.29) where you enter the stor-
age location and the file name. In the dialog section Description below, you can enter notes for 
the PDF file. 

Moreover, the PDF file is created with bookmarks facilitating the navigation in the digital doc-
ument.  

VCmaster export 
VCmaster from the VEIT CHRISTOPH company (formerly BauText) is a word processing program 
with specific extras for structural calculations. 

To start the direct export to VCmaster, 

select Export to RTF on the File menu of the printout report 

or use the button [Export to VCmaster] in the printout report toolbar shown on the left. 

The dialog box shown in Figure 8.29 appears where you have to tick the check box for Direct 
Export to Program VCmaster. 

It is not necessary to enter a file name, but VCmaster should run in the background. To start the 
import module of VCmaster, click [OK]. 
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9. General Functions 
 

9.1 Units and Decimal Places 
The units and decimal places can be modified however you want during the modeling or eval-
uation. All numerical values will be converted or adjusted. 

Changing units and decimal places 
Some dialog boxes provide the button shown on the left which you can use to access the dia-
log box for changing units and decimal places (see Figure 9.6 for dialog box Display Properties). 

To open the dialog box Units and Decimal Places, you can also 

select Units and Decimal Places on the Settings menu. 

 
Figure 9.1: Dialog box Units and Decimal Places 

Three dialog tabs are offered so that you can specify settings separately for Model, Loads and 
Results data. The units and decimal places are summarized in groups. 

The units and decimal places that are relevant for the current table are marked with a red tri-
angle as shown in the figure above. 

Saving and import of units as user profile 
The settings in the dialog box Units and Decimal Places can be saved and reused in other mod-
els. Thus, specific unit profiles for timber models are possible. 

The button shown on the left opens a dialog box where you enter the Name of the new units 
user profile. 
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Figure 9.2: Dialog box Save Profile 

To use this profile as default setting for new models, tick the check box for Save profile as default. 

A user profile can be imported with the button shown on the left. A dialog box opens where 
several profiles are available for selection. A metric and an imperial (Anglo-American) unit pro-
file are preset as default settings. 

 
Figure 9.3: Dialog box Load Profile 

9.2 Language Settings 
The language that has already been selected for installation is preset. Materials and cross-
section tables in the libraries have also been set up by country-specific arrangements. 

To change the graphical user interface (see chapter 4.1), 

select Language (RX-TIMBER) on the Edit menu of the Project Manager. 

 

Figure 9.4: Project Manager menu Edit → Language (RX-TIMBER) 

The changed language settings will be effective after restarting the program. 
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9.3 Display Properties 
The display properties control how graphical objects are represented in the program windows 
and the printout. 

Adjusting the display 
To open the dialog box for adjusting the graphical display, 

select Display Properties on the Settings menu of the RX-TIMBER program. 

Alternatively, window 1.3 Loading offers a button to access the corresponding dialog box: First, 
click the button shown on the left to open the dialog box Load Cases (see Figure 5.29, page 48) 
where you find the button [Display Properties of Selected Load] next to the graphic. 

 

Figure 9.5: Button Display Properties in the dialog box Load Cases 

The dialog box Display Properties appears. 

 
Figure 9.6: Dialog box Display Properties 

The settings for display on the Screen and in the Printout Report are managed in two dialog 
tabs. In this way, it is possible to define adjustments separately for the monitor graphic (for 
example size of support symbols with black background) and for the printout. 
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The Category navigator shows the graphical objects listed in a directory tree. To change the 
display properties of an object, select the relevant entry. Then, adjust the object-specific dis-
play parameters in the dialog section to the right: color, line display, type and arrangement of 
numbering, font, size of load vector etc. 

If you want to define Identical Settings For screen and printout report, use the check box below 
the tabs to synchronize the display properties for screen and printout report. If it is ticked, the 
subsequently defined settings are also enabled in the other dialog tab (Screen or Printout Re-
port) of the current category. Settings that have already been defined cannot be transferred 
subsequently with this function. 

The buttons below the parameters have the following functions: 

 
Opens the Font dialog box for changing type, size and color of font 

 Goes to display parameters of axes for current object 

 Opens the dialog box Relative Positions for arranging descriptions 

 Restores default settings 

Table 9.1: Buttons in dialog box Display Properties 

9.4 Export of Results 
The results of the RX-TIMBER design can be used in other programs. 

Clipboard 
To copy cells selected in the results windows to the Clipboard, press [Ctrl]+[C]. To insert the 
cells, for example in a word processing program, press [Ctrl]+[V]. The headings of table col-
umns are not exported. 

Printout report 
Data of RX-TIMBER programs can be printed in the printout report (see chapter 8.1, page 68) 
where it can be exported. 

Select Export to RTF on the File menu of the printout report. 

The function is described in chapter 8.8.2 on page 85. 

Excel / OpenOffice 
RX-TIMBER provides a function for the direct data export to MS Excel, OpenOffice.org Calc or 
the file format CSV. To open the corresponding dialog box, 

select Export to MS Excel on the File menu of RX-TIMBER. 

The following export dialog box appears. 
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Figure 9.7: Dialog box Export – MS Excel 

When your selection is complete, you can start the export by clicking [OK]. Excel or OpenOffice 
will be started automatically. It is not necessary to run the programs in the background. 

 
Figure 9.8: Result in MS Excel: window 2.3 Design by X-Location 



10  Glued-Laminated Beam 

 

 

92 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

 

10. Glued-Laminated Beam 
The most important functions of RX-TIMBER Glued-Laminated Beam are presented in the 
following by describing two examples. 

In the first example we enter and calculate a pitched cambered beam with inclined bottom 
chord and variable height (Beam Type 6). The second example in chapter 10.2 is the lateral 
buckling analysis of a fish beam (Beam Type 8). 

Start the program by double-clicking the desktop icon Dlubal RX-TIMBER 2.xx (see chapter 
3.2, page 12), and then select Glued Laminated Beam in the Project Manager. 

The data of both examples can also be found in the models 06.gl and 08.gl of the project 
Examples RX-TIMBER that is created automatically during the program installation. However,  
if you are a program beginner, we recommend you to enter the example data manually. 

10.1 Example for Pitched Cambered Beam 

10.1.1 System and Loads 

 

Figure 10.1: System and loads 

Geometry and material 
We use combined glued-laminated timber GL24c as material for the structure. 

The linearly variable cross-section of the beam is defined with hs = 629.2 mm on the support 
edge and hap

 
= 1761 mm in the span center, resulting in an inclination of 12° for the top beam 

side and 8° for the bottom beam side. 

The beam width is 180 mm. 

Load determination 

Load case 1: self-weight 

The load is given by the self-weight of the beam and the building's roof structure. We refer to 
chapter 5.3, page 41 when we determine the load and enter the roof structure. 

In our example, we assume a roof structure of 0.64 kN/m2. With a spacing of 3 m between the 
trusses we get a distributed load of 1.92 kN/m plus beam self-weight. 
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Load case 2: snow 

The construction project lies in zone 1 with a height of 200 m above sea level. Together with 
the shape coefficient we get a snow load of: 

s = 0.8 · 0.65 kN/m² · 3 m =1.56 kN/m 

The snow load is applied as projected length with load direction Z. 

The load case wind is not considered in the example. 

10.1.2 Input Data 

10.1.2.1 Beam Type and Material 

 
Figure 10.2: Window 1.1 Beam Type and Material 

To enter a pitched cambered beam with variable height, we select Beam Type 6 and the mate-
rial Glulam Timber GL24c in window 1.1 Beam Type and Material. 

The program presets a beam with Cantilevers. We deactivate the option for our example be-
cause we want to calculate the beam without cantilevers. 

We design the beam according to EN 1995-1-1:2004-11 and the national annex for Germany 
according to DIN. 

Generally, there is a great danger of failure due to transversal tension for this type of beam. 
Therefore, we want the program to calculate the required Stiffening Elements for Transversal 
Tension. 

Then, we select Steel bars with wood-screw thread. A new dialog box opens offering three 
options to define the Layout of Steel Bars. We select the first option Determine quantity. 
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Figure 10.3: Dialog box Stiffening Elements - Steel Bars with Wood-Screw Threads 

The Nominal diameter of steel bars is 16 mm. The load bearing capacity of the screw Ft,Rk is de-
termined by the strength class of the steel bars 8.8 according to EN 1993-1-8, table 3.4. 
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10.1.2.2 Geometry 

 
Figure 10.4: Window 1.2 Geometry - Pitched Cambered Beam with Variable Height 

In the second program window, we enter the geometry of the beam and building. Based on the 
building dimensions, the wind and snow load generator determines in the program's back-
ground the size of the load area on the roof as well as the attached wall surfaces. The data input 
is interactive: As soon as the geometry is modified, the loading of the beam changes as well. 

We select the following values for our example: Building Height 10.00 m, Building Depth 40.00 m, 
Beam Spacing 3.00 m, entire Beam Length 25.00 m, Support Width 25 cm, Beam Height on Edge 
62.92 cm, Inclination Angle, Top 12°, Inclination Angle, Bottom 8°. 

The Radius of Curvature must be limited in the service class 1-2 according to [1] equation (H.1) 
and [7] clause NA 11.4: 

r = 2.5 · 402 mm + 117.5 · 40 mm = 8700 mm 

To reach an efficient ratio for transversal tension load and timber volume, we define the radius 
R with 20.00 m. 

The Lamella Thickness is 4.0 cm. It is possible to enter any value in a range of 0.5 to 4.0 cm. The 
input field offers a selection list with the default values 3.3 and 4.0 cm. We set 18.0 cm for the 
Cross-section Width. 

Under the table entry Data for Lateral Buckling we specify the value for Spacing of Lateral Sup-
ports with 3.00 m. The Bracing Distance from the beam axis is defined with 31.50 cm. 

The distance e as center distance of the stiffening from the horizontal retention of the bar on 
the support is represented in DIN 1052: 2004-08, figure E.2. The smaller the distance is defined, 
the larger is the moment that must be absorbed by the pinned support because the lever arm 
for the absorption of the tilting moment is reduced. 

( )



 −⋅⋅−⋅= mdd k1

h
e

60
1

80
1

MT  

Equation 10.1: Determination of pinned support according to descriptions for DIN 1052: 2008-12, equation (14) 
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10.1.2.3 Loads 

The first action that we enter in window 1.3 Loading is the Permanent Action, specifying the load 
"self-weight and roof structure". The following values are selected for the Roof Layer. 

• Trapezoidal sheet metal  with 0.15 kN/m2 

• Vapour barrier   with 0.02 kN/m2 

• Rock wool (d = 30 cm)  with 0.30 kN/m2 

• Purlins    with 0.15 kN/m2 

• Gypsum boards incl. strapping with 0.02 kN/m2 

 
Figure 10.5: Window 1.3 Loading 

We use the [...] button occurring in the Roof Layer column to select materials from the library.  
It is also possible to integrate a new loading into the material library. 

The roof structure results in the permanent action gk of 2.62 kN/m. This load includes the self-
weight of the beam. As the beam has a linearly variable height, a trapezoidal load for the self-
weight of the beam is automatically applied. To check the loading, use the button [Show Gen-
erated Loads resp. Define Additional Loads] shown on the left (see for example Figure 5.28, 
page 47). A dialog box opens with a table where you can enter also user-defined loads. 

It would be possible to define an additional Imposed load by using the button shown on the 
left, selecting a load from the table and assigning the corresponding Imposed load category 
from the list for EN 1991-1-1. However, in our example we only define the Service Class 2 for the 
beam. 

To determine the Snow Load, we enter 200 m for the Altitude above sea level. We define the 
Snow load zone SZ 1 by a double-click in the snow load map. 

We do not want to analyze the wind load in our example. Therefore, we set the peak velocity 
pressure to 0.00 in both input fields. 
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10.1.2.4 Control Parameters 

The final input window 1.4 Control Parameters manages the settings for the designs that you 
want to perform. 

 
Figure 10.6: Window 1.4 Control Parameters 

In our example, we analyze the Ultimate limit state, the Serviceability limit state and the 
Fire protection. The fire resistance class is set to R 60. As there is no Charring on the top beam 
side, we clear the relevant check box. 

We check if the remaining settings match the ones shown in the figure above. Finally, the in-
put of the geometry and loads is complete. 
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10.1.3 Calculation 

10.1.3.1 Combinations with RF-COMBI 

The add-on module RF-COMBI is directly integrated in RX-TIMBER. It generates all result com-
binations automatically. Use the [RF-COMBI] button to start the add-on module. 

To avoid generating an unnecessary high number of result combinations, it is recommended 
to Reduce possible result combinations in the window section Supplementary Examination of the 
RF-COMBI window 1.1 General Data. In this way, you make sure that the results of RF-COMBI 
include all governing result combinations but without generating more load cases than neces-
sary. 

Find more information about RF-COMBI in the program manual available for download at 
www.dlubal.com.  

Now, we start the generation of combinations in RF-COMBI with the [Calculation] button. 
Then, we only look at result combination 2. Therefore, we clear the check boxes for all the oth-
er load combinations in window 2.3 Result Combinations - Reduced. Only RC 2 remains ticked. 
Finally, we click [OK] to quit the add-on module RF-COMBI. 

 
Figure 10.7: RF-COMBI window 2.3 Result Combinations - Reduced 

10.1.3.2 Start Calculation 

When all entries have been set according to the specifications, click the [Calculation] button in 
the RX-TIMBER program to start the calculation. 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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10.1.4 Results 

After the calculation the navigator shows more items with information about the Results. 

As the location of the maximum bending stress in the beam is not necessarily the location of 
the maximum moment, RX-TIMBER divides the beam into small sections where it performs the 
designs. If an even more accurate calculation is needed, you can refine the member division in 
window 1.4 Control Parameters, dialog section Calculation Parameters. The designs for these 
division locations can bee seen in window 2.3 Design by X-Location. 

 
Figure 10.8: Window 2.2 Design - All for ultimate limit state design (shear stress at support) 

We look at the [Ultimate Limit State Designs] for the result combination RC 2. Due to the notes 
listed in table column E referring to the equations of EN 1995-1-1: 2004-11, it is easy to under-
stand the analysis. The window section Intermediate results below the table informs you about 
design details of the design currently selected above. 

In the following hand calculations, we apply a linear load of 5.78 kN/m with an averaged beam 
self-weight. RX-TIMBER, however, takes exactly the linearly variable beam height for the self-
weight proportion into account. 

Design of shear stress 
A reduction of the shear force is not necessary for this beam. 
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Design value of strength 
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This value is displayed also in RX-TIMBER for the shear design on the support as shown in 
Figure 10.8. 

Design of bending stress (design 6.4.2) 
As already mentioned, the design for the beam's bending stress is not necessarily performed 
on the location of the maximum bending moment. For our example, we calculate the location 
of the maximum loading and compare the results for this location with the values determined 
by RX-TIMBER. 
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For the design in the compression zone on the upper beam edge we get a material resistance 
of: 
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Figure 10.9: Window 2.2 Design - All for ultimate limit state design (bending stress on compression edge) 

The program's design ratio of 0.60 on the x-location 19.526 deviates insignificantly (see Figure 
10.9). RX-TIMBER does not necessarily perform the design as mentioned on the location with 
the maximum bending stress but analyzes the locations of division. Moreover, an averaged 
beam self-weight is applied in the hand calculations. 

Lateral buckling design 
To stiffen the beam, purlins suspended between the girders are provided, restricting the lateral 
buckling distance to 3.00 m. 
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For the determination of the lateral buckling slenderness the 5 % quantile of the stiffness 
properties is multiplied with the factor 1.4 in accordance with the national annex of Germany. 

For the stability analysis of tapered cross-sections RX-TIMBER applies the cross-section proper-
ties that exist at a distance of the 0.65-fold member length from the end of the member with 
the smaller section. In this way, it is ensured that the design is performed correctly according to 
the equivalent member method.  

According to equation (6.34), this results in: 
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According to equation (6.35) a superposition with compression force must additionally per-
formed. 
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Torsion design 
For beam types of this example the restraint of fork supports causes a torsion of the cross-
section. Therefore, special torsion designs are required, but we don't perform them in our ex-
ample. The specifications can be set in the Details dialog box that you open by clicking the 
[Details] button shown on the left. 

The distance e of the stiffening bracing to be set in window 1.2 Geometry among the entries for 
lateral buckling is significant for the correct application of the procedure. RX-TIMBER increases 
the distance for a tapered cross-section automatically: The starting point for the program is the 
axis of the support. The distance e of the stiffenings is measured from the start of the member 
where it is related to the axis. Thus, the distance is also relevant for the design of the cross-
section's torsion about its axis. 

10.1.5 Documentation 

We click the [Report] button to start the print preview of the calculated data. 

To adjust the printout report, 

select Selection on the Edit menu of the printout report. 

The dialog box Printout Report Selection opens where the program RX-TIMBER is already preset 
in the navigator. In the Results tab, we select only the designs for the Ultimate Limit State by 
clearing the check boxes for Serviceability Limit State and Fire Resistance. 

 
Figure 10.10: Dialog box Printout Report Selection 
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We don't modify the other preset values. Finally, we confirm our selection with the [OK] button. 

 
Figure 10.11: Print preview in printout report 

Further information on the presentation of the printout report can be found in chapter 8. 
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10.2 Example for Fish Beam 
In the previous example calculated for the pitched cambered beam with variable height we 
have seen that the design ratio of the program is slightly higher than the results of the manual 
calculations. This is due to the fact that the designs are calculated by subdividing the beam in-
to a multitude of x-locations. The number of these locations and thus the accuracy of results 
can be set by the number of member divisions defined in window 1.4 Control Parameters. 

The procedure as well as the advantages and disadvantages of this calculation method are 
now described for a fish beam (Beam Type 8).  

 

Figure 10.12: Geometry of fish beam 

10.2.1 Geometry 
The Beam Type 8 presented in this example has a linear rounding in the center area with a 
straight line l1 directed to both supports. The beam height on the support is generated on the 
inner edge of the support and must be identical on the left and the right support. 

When generating the geometry the program reads the beam's geometrical conditions and 
checks if it is possible to integrate the minimum radius of the bottom edge according to [1] 
annex H as well as [7] clause NA11.4 into the inclination of the straight line l1 depending on the 
lamella thickness: If the straight line's inclination becomes too steep or flat because of the 
height of the ridge and thus the radius cannot be integrated anymore into the beam, it is not 
possible to enter an unacceptable value. 

  
Figure 10.13: Definition parameters 
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10.2.2 Lateral Buckling Design 
Generating loads is not described because it is already done in the previous example. To com-
pare the results, we recommend to use the model 08.gl that is automatically created during 
the program installation. For the lateral buckling analysis we only look at result combination 2 
including loads from roof structure and snow. 

RC2 = 1.35 · LC1 + 1.50 · LC41 

In window 1.4 Control Parameters we select 20 divisions for the truss resulting in a relatively 
accurate member division. Then, we click the [Calculation] button. 

 
Figure 10.14: Window 2.2 Design - All for ultimate limit state design 

For the X-location 6.809 m the program's output displays a design ratio of 35 % in the lateral 
torsional stability verification. The relative slenderness ratio is shown with λrel,m = 0.375. Further-
more, the program calculates 120 cm for the equivalent cross-section height h0.65. The equiva-
lent height for the slenderness ratio is assumed by RX-TIMBER, as described in chapter 10.1.4, 
with the height that is available in a distance of 65 % of the entered equivalent member length 
from the member end with the minor cross-section (see DIN 1052:2008-12, 8.4.3 (3), 8.4.3 (4) and 
8.4.4 (2)). 

The equivalent member length for this beam was determined with 2.00. In hand calculations 
we would now determine the height on each point where the length for lateral buckling is re-
duced. With this height value we would determine the stress for the point. The lateral buckling 
factor, for example in the design (6.34) according to DIN EN 1995-1-1, is determined with an 
equivalent height in the distance of 0.65 · lef. 

For the manual calculations we use the following values: 

X-location   = 6.81 m 

Height of cross-section = 1.19 m 

Equivalent height h0.65 = 1.20 m 

Flexural resistance fm,k = 24 N/mm2 (GL24c) 

Beam width b  = 180 mm 
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Relative slenderness according to eq. (6.30) 
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Figure 10.15: Equivalent height in manual calculations 

We see in the figure above that the program, compared to the manual calculations, does not 
calculate with the 0.65-fold but the 0.33-fold effective member length. 

Among other things, this is due to the fact that a program is not able to see if the division into 
X-locations respectively the resulting equivalent height leads to a useful result. Otherwise, it 
could happen in the ridge zone of the beam that the equivalent height is selected behind the 
ridge and thus calculated too low. 
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11. Continuous Beam 
The following example describes the designs according to DIN EN 1995-1-1:2010 presenting a 
two-span beam with span lengths of 4.00 m and 5.00 m. 

The model data is stored in the model 07.dlt of the project Examples RX-TIMBER. We find it 
among the example files of the program Continuous Beam. 

11.1 System and Loads 

 

Figure 11.1: System and loads 

Model 
Cross-section:  b/d = 70/240 mm  NKL 1      kdef = 0.6 

Material:   CT C24 

The floor is built above living space. This results in the imposed load category A and the LDC 
medium-term. 

Span lengths:  l1 = 4.00m l2 = 5.00m 

Loads 
Load case 1: self-weight and roof finishes  g = 1.7 kN/m LDC = permanent 

Load case 2: imposed load   q = 2.0 kN/m LDC = medium-term 

Result combinations 
Load bearing capacity RC 1 = 1.35 · LC1 = 2.3 kN/m 

RC 2 = 1.35 · LC1 + 1.5 · LC 2 = 5.3 kN/m 

Serviceability 

• Characteristic situations 

 Restriction of deflection: 300/lwwww inst,i,qi,0inst,1,qinst,ginst ≤⋅ψ++= ∑  

m/kN7.3m/kN0.2m/kN7.10.1p0.1gGC =+=⋅+⋅=  

• Quasi-permanent design situation 

( ) ( ) 300/lwk1wk1ww cdef
1i

inst,i,qi,2definst,gfin,net ≤−+⋅⋅ψ++⋅= ∑
≥

 

( ) m/kN68.36.1m/kN23.0m/kN7.1)6.01(k1pg)k1(GQ defi,2def =⋅⋅+⋅+=+⋅⋅ψ+⋅+=  

Comparing the results from the manual calculations with the ones calculated by the program is 
easier when we don't take into account the beam's self-weight. 
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11.2 Input of Model Data 

11.2.1 General Data 

Start the program by double-clicking the desktop icon Dlubal RX-TIMBER 2.xx (see chapter 
3.2, page 12), and then select Continuous Beam in the Project Manager. 

 
Figure 11.2: Window 1.1 General Data 

We select softwood timber with the strength grade C24 as Material. 

The Beam Rotation about its own axis is set to β = 0°, we don't modify it. 
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11.2.2 Geometry 

In the second window, we enter the number of spans, the span lengths as well as the support 
and release conditions of the beam. Optionally, we can define cantilevers or assign user-
defined spring constants to the supports and releases. 

 
Figure 11.3: Window 1.2 Geometry 

For our example we set: 

• Number of spans  n: 2 

• Total length L: 9.20 m 

• Two spans with Span Length l: 4.00 m and 5.00 m 

• Support Width b: 20 cm 

 The first Location X of 0.10 m results from the support width. 

For the Type of Support we select a Hinged support for Support No. 1 and two Hinged free sup-
ports for No. 2 and 3 in direction X. By using the User-defined list option it would be possible to 
assign any individual degree of freedom as well as translational and rotational spring stiffness-
es to the support. 

11.2.3 Cross-section 
In the third window, we define cross-section dimensions and tapers, if applicable, that are ad-
justed to the moment diagrams. In the window section Cross-section Changes, we can describe 
the beam by specifying the length and height as well as the inclination of the change. 

For the Cross-Section we enter the Dimensions b = 7 cm and h = 24 cm. The Origin Position is 
set for the Beam Start. We don't modify any of the remaining values (see Figure 11.4). 

Below the table we see information about Area, Volume and Weight of the beam. We can dis-
play the beam's cross-section properties like the elastic section modulus etc. by clicking the 
[Info] button shown on the left. 
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Figure 11.4: Window 1.3 Cross-Section 

11.2.4 Loads 
In the Loads table we enter the different load types. The program provides uniformly distribut-
ed loads, block loads, linearly variable loads, concentrated loads and moments. These loads can 
be entered separately for the directions x, y and z in the dialog box Load Cases (see Figure 11.6). 

 
Figure 11.5: Window 1.4 Loads 

In our example, we select a load per length. We enter the loads as shown in the figure above. 
We set the wind and snow loads manually to zero. 



11  Continuous Beam 

 

 

111 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

We use the button [Show Generated Loads] shown on the left to open the dialog box Load 
Cases where we can check the generated loads. 

 
Figure 11.6: Dialog box Load Cases 

The program generates a concentrated load resulting from the line load beyond the support 
axis, preventing a negative moment on the short overhang of the beam. 

We deactivate the Self-weight for the calculation by clearing its check box. 

11.2.5 Control Parameters 
In window 1.5 Control Parameters (see Figure 11.7) we define the designs for the Ultimate limit 
State, the Serviceability limit state and the Fire protection. For the serviceability limit state design 
we can specify a Precamber. We do without the designs for the fire protection and deactivate 
the corresponding option. 

In the window section To Display, we tick the check boxes of all options: Support forces, Defor-
mations and Support compression. 

We don't want to perform a Moment redistribution for non-used cross-section zones according 
to DIN EN 1990, clause 1.5.6.4. 

The Number of member divisions determines the locations where RX-TIMBER performs the de-
signs. 
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Figure 11.7: Window 1.5 Control Parameters 

We use the [Nat. Annex] button shown on the left to open the dialog box National Annex Set-
tings where we can check the partial safety factors and the limit values of the deformations. 

 
Figure 11.8: Dialog box National Annex Settings 

The deformation can be defined independently of span and cantilever. 
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11.2.6 Effective Lengths 
To be on the safe side, we set factor β to 1.0 in our example. The remaining values are preset 
by the program so that we don't need to enter any further data in this table. 

 
Figure 11.9 Window 1.6 Effective Lengths 

11.3 RF-COMBI 
The add-on module RF-COMBI used for the creation of combinations according to DIN EN 1990 
and DIN EN 1995-1-1 is integrated in RX-TIMBER: The load cases are combined automatically so 
that we normally don't need to open the add-on module. However, we want to check the com-
binations that are generated in the background. We access the add-on module by using the 
[RF-COMBI] button. 

We set CA2 in the case list above the RF-COMBI navigator and look at the combinatorics of 
Serviceability. 

The Deformation coefficient is defined automatically with kdef = 0.6 in accordance with the 
respective service class. In our example, we have specified the service class 1. 
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Figure 11.10: Add-on module RF-COMBI, case 2 Serviceability Limit State Design 

In the next window 1.2 Load Cases in Actions, the loads are assigned to the relevant actions, 
and so the LDC is created. 

For the imposed load the program already takes into account the load-duration class accord-
ing to action A and the load duration medium-term. 

 
Figure 11.11: RF-COMBI window 1.2 Load Cases in Actions 

For more information on the features of RF-COMBI, see the manual available for download at 
www.dlubal.com. For our simple example, the actions and respective load-duration classes 
have automatically been created correctly. 

http://www.dlubal.com/manuals-for-category-timber-design.aspx


11  Continuous Beam 

 

 

115 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

 

The used [Coefficients] can be checked in a separate dialog box. 

 
Figure 11.12: Dialog box Coefficients, tab Partial Safety Coefficients 

After the [Calculation] we can check the results of the combinatorics by our hand calculations 
(see chapter 11.1, page 107). The calculation is performed correctly (see Figure 11.13). 

The increased number of combinations in RF-COMBI is a result of the additionally required 
combination of the loads applied by span on the continuous beam. 



11  Continuous Beam 

 

 

116 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 
Figure 11.13: RF-COMBI window 2.2 Result Combinations 

We have the possibility to select particular combinations for the calculation in the timber pro-
gram Continuous Beam. However, this time we want to consider all combinations of window 2.2 
for our example. 

We click [OK] to return to RX-TIMBER Continuous Beam. 
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11.4 Results 

11.4.1 Result combinations 
We use the [Calculation] button to calculate the data. Results window 2.1 displays the designs 
of all combinations for the ultimate and the serviceability limit state including corresponding 
design ratio. 

 
Figure 11.14: Window 2.1 Result Combinations 

The factor kmod used to consider the time-dependent settlement behavior due to load duration 
and specific climatic characteristics of timber is applied automatically to the required value ac-
cording to the LDC and the SECL. 

To check only the overstressed designs, we use the button [Shows only rows with ratios >1] 
which is available in each results window of RX-TIMBER. We click the button [Colored Relation 
Scale] to display and hide the colored representation of the design ratios. 

We use the button [Load of Load Cases] to check the loads and the classes of the load actions 
that have been applied to the current result combination (that is the RC table row where the 
cursor is placed). 
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Figure 11.15: Dialog box Load Cases 

11.4.2 Design by Beam 
This window shows all governing designs for the entire beam. 

 
Figure 11.16: Window 2.2 Design by Beam 
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All factors and required design internal forces can be checked interactively: We click the rele-
vant design in the table above to display all Intermediate results of the design in the window 
section below. 

With the button [Result Diagrams] shown on the left we can check the distribution of internal 
forces and design ratios graphically. We find the button above the cross-section graphic. A 
new window opens where we can select the internal forces and deflections of the beam specif-
ically for each result combination. The result combination can be set in the list above. 

 
Figure 11.17: Dialog box Result Diagram on Member 

Under the navigator entry Result Combinations, we can select the Both option to look at the 
reduction of forces according to the settings in the Details dialog box. This option is a useful 
function to evaluate for example the effect of the shear force reduction. 

We use the [Print] button to transfer this graphic directly to the printout report. 
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11.4.3 Ultimate Limit State 
In window 2.2 Design by Beam, it is also possible to display the designs only for the ultimate 
limit state: We disable the display for the serviceability limit state designs by clicking the but-
ton [Serviceability Limit State Designs]. 

 
Figure 11.18: Window 2.2 Design by Beam for ultimate limit state only 

The results of RX-TIMBER are checked by manual calculations. 

Loading due to shear force on support according to 6.1.7 

The maximum shear loading of 16.02 kN is determined above the central support. By means of 
the reduction according to 6.1.7 (NA.5) it is possible to reduce the loading to 14.2 kN and thus 
to the shear force occurring in a distance of 24 cm (= h) from the support. 
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Despite the reduction of the shear force, the design is not fulfilled. If glued-laminated timber 
was used, the design could be fulfilled. 

Bending load according to 6.1.6 

The maximum loading is available above the support center due to the supporting moment. 
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Even if a moment reduction of 10 % was applied, which is not done in this case, the design 
ratio would be determined with 126 % for a design moment of 12.5 kNm. Only two options 
remain: selecting either a higher strength grade, for example C 35, or a larger cross-section. 

Support compression according to 6.1.5 

Like we expected the maximum support compression is reached at the central support with a 
loading of 30 kN. RX-TIMBER increases automatically the contact area by the allowed 3 cm 
along the timber grain. Thus, for the selected support with a width of 20 cm we get an effective 
area of 182 cm². 

The maximum loading for this design is also determined above the support center due to the 
supporting moment. 
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Flexural members without compressive force according to 6.3.3 (lateral buckling 
analysis) 

Additionally, we have to perform the stability analysis for this beam. The moment loading to 
be designed is identical with the beam's loading in the bending analysis within the ultimate 
limit state design. 

Thus, bending stress and flexural resistance are identical with the design according to 10.2.6. 
Therefore, we don't describe it again. 
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The overload to be expected for this high and slender beam could be reduced by reducing the 
buckling length. It would be possible to model a continuous lateral support in RX-TIMBER, 
which is represented in reality by a screwed-on OSB-boarding, by removing the buckling op-
tion in window 1.6 Effective Lengths. 
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11.4.4 Serviceability Limit State 
In window 2.2 Design by Beam, we disable the display for the ULS designs by clicking the button 
[Ultimate Limit State Designs] so that we only see the serviceability limit state design results. 

To eliminate the overloads from the ultimate limit state, we change the strength class of the 
material for this example from C24 to C35. Moreover, we calculate the beam as centrically fixed 
by defining the lengths for lateral buckling lef manually with 2.0 m respectively 2.5 m in win-
dow 1.6 Effective Lengths. 

After the [Calculation] with the specified settings the results look much better. 

 
Figure 11.19: Window 2.2 Design by Beam 

We perform the deflection analysis exemplarily for the quasi-permanent design situation. The 
loading from an imposed load becomes governing only in the right span. 

 
Figure 11.20: Result diagrams in RX-TIMBER for RC8 
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Loading according to SC (serviceability - characteristic) in right span: 3.7 kN/m 

Loading according to SC in left span:     1.7 kN/m 

Moment of span:        7.93 kNm 

Supporting moment:      -7.93 kNm 

Deflection 
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To adjust the deflection design to the modified elastic modulus, we divide our result by 1.3  
(E = 1.300 kN/cm²) and receive a deflection of 1.77 cm.  

For this design according to equation (42) RX-TIMBER shows us a deflection of 16.9 mm. 

Thus, the deflection of 16.9 mm lies slightly above the limit value of 

l/300 = 5000 mm/300 = 16.7 mm. 

11.4.5 Support Forces 
This window shows us the support forces of all load cases and result combinations. The sup-
port forces are listed separately for the design situations (ultimate limit state, serviceability lim-
it state and, if available, fire protection). 

In addition, the window presents the maximum and minimum values for each design situation. 

 
Figure 11.21: Window 2.5 Support Forces 

11.5 Documentation 
The documentation in the printout report contains all performed designs and loadings. The  
elements of the report can be selected specifically and adjusted to individual needs. The print-
out report is described in detail in chapter 8. 
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12. Column 
We perform the ultimate and the serviceability limit state design according to EN 1995-1-1 for 
a log wood column that is restrained and stressed by compression and bending. 

The model data is stored in the model 02.clm of the project Examples RX-TIMBER. We find it 
among the example files of the program Column. 

12.1 System and Loads 

 

Figure 12.1: System and loads 

Model 

Cross-section:  d = 21 cm 

Material:   CT C24 

Height:   h = 3.20 m 

SECL:   1 

LDC:   permanent 

Loading 

Load case 1: self-weight  F = 45 kN 

Load case 2: wind  w = 1.5 kN/m 

Design values for load bearing capacity 

N = 1.35 · F = 1.35 · 45 KN = 60.75 kN  (kmod = 0.6)  

q = 1.5 · w = 1.5 · 1.5 KN/m = 2.25 kN/m (kmod = 0.9) 
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12.2 Input Data 

12.2.1 General Data 

 
Figure 12.2: Window 1.1 System 

In window 1.1 System, we define the geometric parameters of the column. 

We design the Column Type Bracket According to Standard EN 1995-1-1:2004-11 and the 
National Annex of Germany according to DIN. 

The Elastic Foundation is defined only for the Footing column. We use the [Edit] button shown 
on the left to check if all degrees of freedom are restricted. 

 
Figure 12.3: Dialog box Edit Nodal Support - Restraint of Footing 

Then, we define the Column height with 3.20 m. For our bracket model we set each Effective 
length to the doubled value of 6.40 m. 

As Material we select Poplar and Softwood Timber with the strength grade C24. We select 
the material directly by using the drop-down list. We can also use the [Library] button. 

The Cross-section is Round having a diameter of 21 cm. 
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12.2.2 Loads 
Load case no. 1 for the self-weight is created automatically. We enter the self-weight as a 
Permanent Action representing a nodal force of 45 kN on the column head. 

The Wind Load is acting in the global direction X as distributed load wk,X with 1.50 kN/m. 

 
Figure 12.4: Window 1.2 Loads 

We use the button [Show Generated Loads] to open the graphical display of the load cases. 

 
Figure 12.5: Dialog box Load Cases 

We clear the check box used to consider the Self-weight for LC1 automatically. 
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12.2.3 RF-COMBI 
Load cases LC21 Imposed Load and LC41 Snow are generated automatically (see Figure 12.5). 
However, they do not contain any loads because neither imposed nor snow loads were de-
fined in window 1.2. 

By means of the add-on module [RF-COMBI] it is possible to exclude these load cases from the 
generation of combinations. 

 
Figure 12.6: RF-COMBI window 1.2 Load Cases in Actions 

We select the two actions AC2 and AC3 in the window section Actions and delete them by 
using the button shown on the left. 

Then, in the list above the module navigator, we set the generation case CA2 - Serviceability 
Limit State Design and repeat the delete procedure. 

We click the [OK] button to transfer the modifications to RX-TIMBER Column. 
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12.2.4 Control Parameters 
We perform the Ultimate limit state and the Serviceability limit state design. 

 
Figure 12.7: Window 1.3 Control Parameters 

The [Nat. Annex] button shown on the left provides access to significant design parameters 
such as partial safety and modification factors as well as limit values for deformations (see Fig-
ure 6.3, page 56). 

We don't need to modify the default settings of the dialog box National Annex Settings for our 
example. 
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12.3 Results 

12.3.1 Result Combinations 
After the [Calculation] the program shows the following designs for the generated result com-
binations. 

 
Figure 12.8: Window 2.1 Result Combinations 

The window shows the design ratios for each result combination. The results are listed in two 
blocks sorted by the ultimate and the serviceability limit state design. 

We use the buttons shown on the left to check the [Load of Load Cases] and the internal forces 
in the form of [Result Diagrams]. 
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12.3.2 Designs 
Window 2.2 Design - All lists the governing designs of the column. 

 
Figure 12.9: Window 2.2 Design - All 

To explain the calculation of RX-TIMBER, we check some of the designs by hand calculations. 

Loading due to shear force according to 6.1.7 
The maximum shear loading of 7.2 kN is available at the column base in RC2.  

Shear stress 

The effective cross-section area of the cross-section is reduced by 50 % by a shear correction 
factor. 
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Compression load according to 6.3.2 (stability) 
Again, the maximum loading is available in the support area, but this time it is due to the 
modification factors in RC1 with the LDC 'permanent'. 
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Bending and compression according to 6.3.2 
Again, the governing design criterion is available in the support area for RC2. 

Compressive stress 

2d
d,0,c cm/kN18.0

²cm4.346

kN75.60

A

N
===σ  

Compressive strength 

2
2

d,0,c cm/kN62.1
3.1

cm/kN1.20.1
f =

⋅
=  

Governing radius of gyration 

cm25.5
*r

r*
4

A

I
i

2

4

y
y =

π

π

==  

Slenderness 

9.121A
I

leff =⋅=λ  

Relative slenderness ratio 

07.2
E

f

05.0

k,0,c
c,rel =

π
λ

=λ  

k-factor 

81.2])3.0(ß1[5.0k c,rel
2

c,relc =λ+−λ⋅+⋅=  

Buckling coefficient 

21.0
kk

1
k

c,rel
22

c =
λ−+

=  

Lateral buckling factor km according to 6.1.6:  1.0 

Design according to equation (6.23) 

122.1
62.16

0
7.0

85.10.1
27.1

62.121.0
18.0

f
k

fkfk d,z,m

d,z,m
m

d,y,mm

d,y,m

d,0,cc

d,0,c >=⋅+
⋅

+
⋅

=
σ
⋅+

⋅

σ
+

⋅
σ

 



12  Column 

 

 

132 Program RX-TIMBER © 2013 Dlubal Software GmbH 

12.3.3 Serviceability 
The serviceability limit state design required to prevent damages to non-structural components 
is performed according to EN 1995-1-1, clause 7.2. 

 
Figure 12.10: Window 2.2 Design - All (filter for serviceability limit state) 

Due to the bracket's small allowable deformation of I/150, the characteristic design situation is 
governing. 
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The result matches the designs of RX-TIMBER. 

12.3.4 Other Results Windows 
The remaining results windows as well as the printout report documentation are similar to the 
ones described in the examples presented in chapter 10 and 11. 
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13. Frame 
This example presents the ultimate limit state design according to EN 1995-1-1 by describing a 
symmetrical frame. The column is inward-inclined, the frame joint is designed as finger-jointed 
connection with intermediate piece. 

The model data is stored in the model 01.frm of the project Examples RX-TIMBER. We find it 
among the example files of the program Frame. 

13.1 System and Loads 

 

Figure 13.1: System and loads 

Model 
Cross-section width: b = 30 cm 

Cross-section depth in footing: ha = 35 cm 

Cross-section depth at vertex: hf = 30 cm 

Cross-section depth at frame joint: h1 = 70 cm 

Length of inserted wedge: lzw = 40 cm 

Loading 
Action 1: self-weight/roof finishes  g = 4.32 kN/m LDC = permanent 

Action 2: snow  SZ 1, 200 m LDC = short-term 

Action 3: wind WZ 1, TC II LDC = short-term 

The different snow and wind load cases are created automatically by the load generators 
integrated in the program. 

The load cases for the ultimate limit state design are combined according to EN 1990 and  
EN 1995. 
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13.2 Input of Model Data 

13.2.1 General Data 

Start the program by double-clicking the desktop icon Dlubal RX-TIMBER 2.xx (see chapter 3.2, 
page 12), and then select Frame in the Project Manager. 

 
Figure 13.2: Window 1.1 Frame Type and Material 

The material can be selected in the list or the extensive library. In addition, the [Library] offers 
us the possibility to specify a user-defined timber grade with specific strength properties. 

We select Gluelam Timber with the strength grade GL32c as Material. 

We design the frame According to Standard EN 1995-1-1:2004-11 and the National Annex for 
Germany according to DIN. 

We select a Frame Type with Column inside sloping (thus the outside is in vertical position) 
and Symmetrical arrangement. 

The Frame Joint Type is a Finger joint defined With intermediate piece. 

In the window section Direction of Lamellas, we specify the lamellas to run Parallel to outer 
edge. 
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13.2.2 Geometry 
In the second window, we enter the number of spans, the span lengths as well as the support 
and release conditions of the beam. Optionally, we could define cantilevers or assign user-
defined spring constants to the supports and releases. 

We enter Building Dimensions and Cross-Section in our example as shown in the figure below. 

 
Figure 13.3: Window 1.2 Geometry 

The Frame Geometry is defined by the following parameters: 

 
Figure 13.4: Parameters of Frame Geometry 

Under the Data for Buckling, we specify that the Left Column as well as the Left Beam are  
Endangered by Lateral Buckling (see Figure 13.5). 

If lateral supports are available, we can determine the spacing c for these intermediate sup-
ports. However, we don't do it in our example. 
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Figure 13.5: Parameters for Buckling 

By ticking the User-defined option we activate two fields for entering the Coefficient for effective 
length directly. However, we do without this option and keep the presettings of the program. 

The parameter list continues with specifications for an Attic, if applicable. We don't enter data. 

Finally, we can check significant Information Parameters of the frame geometry. 

 
Figure 13.6: Information Parameters 
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13.2.3 Loading 
The first action that we enter in window 1.3 Loads is the Permanent Action for the load "self-
weight and roof structure". The following values are selected for the Roof Layer. 

• Trapezoidal sheet metal   with 0.15 kN/m2 

• Purlins     with 0.15 kN/m2 

• Vapour barrier    with 0.02 kN/m2 

• Rock wool (d = 20 cm)   with 0.20 kN/m2 

• Oriented strand boards (OSB) (d = 25 mm) with 0.15 kN/m2 

 
Figure 13.7: Window 1.3 Loads 

We use the [...] button occurring in the Roof Layer column to select materials in a library. 

The roof structure results in the permanent action gk of 4.06 kN/m. This load includes the self-
weight of the beam. As the beam has a linearly variable height, the self-weight of the beam is 
automatically applied as trapezoidal load. 

It would be possible to define an additional Imposed load by using the button shown on the 
left, selecting a load from the table and assigning the corresponding Imposed load category 
from the list for EN 1991-1-1. However, in our example we only define the Service Class 2 for the 
beam. 

To determine the Snow Load, we enter 200 m for the Altitude above sea level. The Snow load 
zone SZ 1 can be defined by a double-click in the snow load map. 

For our example we Determine automatically the Wind Load. We only specify the Wind zone 
WZ 1 and the Terrain category TC II. Informative dialog boxes facilitate the assignment. 
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We use the button [Show Generated Loads] shown on the left to open the dialog box Load 
Cases where we can check the generated loads. 

 
Figure 13.8: Dialog box Load Cases with list of generated snow and wind loads 

The dimensions of the building are decisive for the wind load generation. Based on the dimen-
sions specified in window 1.2 Geometry, the program determines the values in column F, G, H 
and I according to [4] or [11] and generates the wind loads accordingly. 

For the zones where compressive as well as suction forces are applied, the program creates 
several load cases for each wind action with the corresponding suction or compressive forces. 
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13.2.4 Control Parameters 
In window 1.4 Control Parameters, we set only the design of the Ultimate limit state. We clear 
the check boxes for Static equilibrium, Serviceability limit state and Fire protection. 

 
Figure 13.9: Window 1.4 Control Parameters 

In the window section To Display, we tick the option Support forces. 

We want the Support Modelling to be defined with Horizontal fixed supports on both sides. 

We don't modify the presettings in the window sections Special Settings for Glulam and Calcu-
lation Parameters. 
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13.2.5 RF-COMBI 
The add-on module RF-COMBI integrated in RX-TIMBER combines the load cases automatical-
ly. We don't need to open RF-COMBI. However, we want to check the combinations that are 
generated in the background. We access the add-on module by using the [RF-COMBI] button. 

 
Figure 13.10: Add-on module RF-COMBI 

We create combinations by clicking the [Calculation] button. 

 
Figure 13.11: RF-COMBI window 2.2 Result Combinations 

We click [OK] to return to RX-TIMBER Frame. 
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13.3 Results 

13.3.1 Result Combinations 
We start the calculation in RX-TIMBER by clicking the [Calculation] button shown on the left. 

The designs of the combinations are shown with the respective design ratios in module win-
dow 2.1. 

 
Figure 13.12: Window 2.1 Result Combinations 

The factor kmod used to consider the time-dependent settlement behavior due to load duration 
and specific climatic characteristics of timber is applied automatically to the required value ac-
cording to the LDC and the SECL. 

We use the button [Load of Load Cases] to check the loads and the classes of the load actions 
that refer to the current result combination (that is the RC table row where the cursor is placed). 
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13.3.2 Designs 
The window lists all designs that are governing for the entire frame. 

 
Figure 13.13: Window 2.2 Design - All 

The factors and design internal forces can be checked interactively: We click a design in the ta-
ble above to display all Intermediate results of the design in the window section below. 

The results calculated by the program are checked by manual calculations. 

Shear due to shear force Vz according to 6.1.7 
The maximum shear force of 53.88 kN occurs at the left column base in RC2. 
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Uniaxial bending and compression on edge parallel to grain 
The cross-section resistance is analyzed according to clause 6.4.2 and 6.2.4. 

The maximum loading due to bending and compression occurs in the left frame joint in RC2. 
The [Result Diagrams] represent the internal forces on the members stringed together if RC2 is 
set in the list above. 

 
Figure 13.14: Distribution of internal forces N and My in RC2 

RX-TIMBER designs the cross-section resistance on the location X = 3.12 as follows:  

 
Figure 13.15: Design of cross-section resistance for bending and compression on edge parallel to grain 
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Uniaxial bending and compression on cut edge (compression edge) 
The maximum loading occurs on the same location X, again in RC2. 

 
Figure 13.16: Design of cross-section resistance for bending and compression on cut edge 

The same compressive and bending stresses are available like for the edge parallel to grain 
(see above). For the design on the cut edge the factor km,α is decisive. 
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Stability for uniaxial bending and compression force acc. to 6.3.2 
For the stability analysis the lateral buckling design is given for uniaxial bending about the 
member axis y with compression force to be governing. 

 
Figure 13.17: Stability designs 

The governing location X = 2.496 m is determined on the left column. The following internal 
forces of RC2 are designed: 

• Axial force  Nd = 78.64 kN 

• Moment  My,d = 134.63 kNm  
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Figure 13.18: Stability analysis for uniaxial bending and compression according to 6.3.2 

Finger-jointed connection acc. to DIN EN 1995-1-1/NA 2009, NA.11.3 
For the design of the finger-jointed connection we first calculate the buckling lengths and 
stresses as presented above. Again, the internal forces of RC2 prove to be governing. In this 
case, they are available on the location X = 3.12. 
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Figure 13.19: Design of finger-jointed connection 

13.3.3 Other Results Windows 
The remaining results windows as well as the printout report documentation are similar to the 
ones described in the examples presented in chapter 10 and 11. 
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14. Purlin 
This example presents the ultimate limit state designs of a coupled purlin with irregular span 
spacings. The analysis is performed according to EN 1995-1-1:2004-11 with the national annex 
ÖNORM B 1995-1-1:2009-07. 

The model data is stored in the model 01.pft of the project Examples RX-TIMBER. We find it 
among the example files of the program Purlin. 

14.1 System and Loads 

 

Figure 14.1: System 

Model 
Cross-section:  b/d = 14/26 cm 

Material:   coniferous timber C24 

Span lengths:  l1 = l3 = 4.30m  l2 = 5.00m 

Roof inclination:  6.0° 

Purlin axis:  inclined in roof plane 

Coupling:  nail connection d = 8 mm, l = 280 mm as shown in Figure 14.2 

 

Figure 14.2: Purlin connection plan 

Loading 
Load case 1: self-weight and roof finishes  g = 1.6 kN/m LDC = permanent 

Load case 2: snow load  SZ 2, 400 m LDC = short-term 

Load case 3: wind load terrain category II LDC = short-term 

The loads for snow and wind are determined automatically by the load generators integrated 
in the program. 

The actions for the ultimate limit state design need to be combined according to EN 1990 and 
EN 1995 with the national annex for Austria. 
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14.2 Input of Model Data 

14.2.1 General Data 

Start the program by double-clicking the desktop icon Dlubal RX-TIMBER 2.xx (see chapter 3.2, 
page 12), and then select Purlin in the Project Manager. 

 
Figure 14.3: Window 1.1 Beam Type and Material 

We select softwood timber with the strength grade C24 as Material. 

The Roof Type is a Monopitch roof. We design the beam According to Standard EN 1995-1-1: 
2004-11 and the National Annex for Austria according to ÖNORM. 

The Beam Type is represented by a Purlin. Depending on our selection, we can define releases 
or couplings in the subsequent program windows. 
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14.2.2 Geometry 
In the second window, we enter the number of spans, the span lengths as well as the roof pa-
rameters and support conditions of the purlin. 

 
Figure 14.4: Window 1.2 Geometry, tab Roof Parameters 

For our example we set: 

• Number of spans n:  3 

• Total length L:  13.80 m 

As the span lengths are different in size, we clear the check box for Identical span lengths. 

We enter the geometric settings in the Roof Parameters tab as shown in the figure above. The 
purlin's axes are adjusted to the roof's inclination of 6.0°. Therefore, we clear the check box for 
Purlin with Vertical Axis. 

In the second tab Supports, we can define the span lengths and support widths. 

 
Figure 14.5: Window 1.2 Geometry, tab Supports 

The Location X results from the span length and the support width that we enter as shown in 
the figure above. We define the purlin restrained on the first support in longitudinal direction, 
the remaining supports are hinged and can be shifted freely in X. 
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14.2.3 Cross-section and Coupling 
In the next window, we define the cross-section dimensions, the couplings and the coupling 
elements. 

For the Cross-Section we enter the Dimensions b = 14 cm and h = 26 cm.  

 
Figure 14.6: Window 1.3 Cross-Section and Coupling 

The Couplings are provided for All inner supports. 

We don't modify the preset Coupling Lengths. We use the [Info] button shown on the left to 
check the connection plan of the purlin (see Figure 14.2, page 148). 

We use Nails as Coupling Elements: 

• Number n: 6 

• Diameter D: 8 mm 

• Length L:  280 mm 

• Type:  Prebored 
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14.2.4 Loads 
This window manages the different types of loads. 

 
Figure 14.7: Window 1.4 Loads 

We enter the Permanent Action as shown in the figure above. We use the [...] button to quickly 
select the materials in the library. 

There is no Imposed load available in our example. 

We specify the Snow Load with an altitude of 400 m above sea level and Determine the load 
automatically. 

• Snow load zone SZ:  2 

• Topography type TT: Normal 

We click the [Info] button to open a map where the snow load zone can be selected also 
graphically (see Figure 14.8). 

The Wind Load is Determined automatically as well. We just specify the Terrain category II. 

We click the [Info] button shown on the left to get detailed information on the single terrain 
categories. 
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Figure 14.8: Map showing snow load zones for Austria 

We use the button [Show Generated Loads] shown on the left to open the dialog box Load 
Cases where we can check the generated loads. 

 
Figure 14.9: Dialog box Load Cases 
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14.2.5 Control Parameters 
In window 1.5 Control Parameters, we set only the Ultimate limit state for the design (the ser-
viceability limit state design is described in chapter 11.4.4 on page 122). 

In the window section Calculation Parameters, we activate the Moment redistribution accord-
ing to ÖNORM 1990. We don't modify the default setting of 10 %. 

Finally, we define the number of member divisions with 20. 

 
Figure 14.10: Window 1.5 Control Parameters 

We use the button [Nat. Annex] to open the dialog box National Annex Settings where we can 
check the partial safety and modification factors preset for ÖNORM B 1995-1-1. It is not neces-
sary to change them. 
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14.2.6 Effective Lengths 
To be on the safe side, we select the factor β with 1.0 in our example. The values are preset by 
the program so that no data modification is required in this window. 

 
Figure 14.11 Window 1.6 Effective Lengths 

14.2.7 Details 
We click the [Details] button to open a dialog box offering specific design settings. 

 
Figure 14.12: Dialog box Details 

In this dialog box, we tick the options Moment reduction on supports and Reduction of shear 
forces. 



14  Purlin 

 

 

156 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 

14.2.8 RF-COMBI 
We use the button [RF-COMBI] shown on the left to access the add-on module RF-COMBI inte-
grated in RX-TIMBER. In RF-COMBI we can check the combinations generated in the program's 
background according to EN 1990 and EN 1995. The load cases are combined automatically so 
that we normally don't need to open the add-on module. 

We have a look at window 1.2 Load Cases in Actions. For our simple example, the actions and 
respective load-duration classes are created correctly by the program. 

In action AC4 Wind Loads the load cases 51 to 58 are summarized as acting alternatively. The 
load-duration class is preset with Short-term. 

 
Figure 14.13: RF-COMBI window 1.2 Load Cases in Actions 

For more detailed information about the features of RF-COMBI, see the manual available for 
download at www.dlubal.com. We click [OK] to return to RX-TIMBER Purlin. 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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14.3 Results 
14.3.1 Result Combinations 
We use the [Calculation] button to calculate the entered data. Window 2.1 shows the ultimate 
limit state designs for all combinations together with the respective design ratios. 

 
Figure 14.14: Window 2.1 Result Combinations 

14.3.2 Ultimate Limit State Designs 
Window 2.2 Design by Beam lists the governing designs of the purlin. 

 
Figure 14.15: Window 2.2 Design by Beam 
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All factors and design internal forces can be checked interactively: We click a design in the 
table above to display all Intermediate results of the design in the window section below. 

The results of RX-TIMBER are checked by manual calculations. 

Shear due to shear force Vz according to 6.1.7 
The maximum shear force of 19.00 kN occurs on the inner supports in RC4. 

 
Figure 14.16: Distribution of shear force Vz in RC4 

The support width of 20 cm results in a reduced design shear force of 18.22 on the support 
edge. 
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Biaxial bending according to 6.1.6 
The maximum loading occurs in the middle of the first span, again in RC4. The graphic with the 
result diagrams below shows the mathematical diagrams as well as the moment diagrams re-
duced or redistributed for the design. 

 

Figure 14.17: Distribution of moments My and Mz in RC4 with representation of original and modified values 
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governing: 0.44 < 1 



14  Purlin 

 

 

160 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 
Figure 14.18: Designs for biaxial bending 

Coupling elements for shear and tension due to biaxial bending acc. to 8 
We have to design the coupling elements for both sides of the coupling. RX-TIMBER determines 
the maximum design criterion for the right side of the first intermediate support. Again, the in-
ternal forces of RC4 are governing. 

 
Figure 14.19: Design of coupling elements 
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Right side 

Design force in couplings kN52.16
m5.0

kNm26.8

u

M
K d,y

d,z ===
 

kN73.1
m5.0

kNm87.0

u

M
K d,z

d,y ===  

Bearing capacity of coupling kN41.28kN734.46FnF Rk,vefRd,z,v =⋅=⋅=  

kN17.13kN195.26FnF Rk,axefRd,y,v =⋅=⋅=  

where Load bearing capacity for nail per shear joint according to eq. (8.6) with gov-
erning condition (f) (percentage of cable effects are not applied in RX-TIMBER) 

=⋅⋅⋅⋅= dfM215.1F k,1,hRk,yRk,v
 

 
kN734.410840.2640115215.1 3 =⋅⋅⋅⋅⋅= −

 
Pull-off strength for nail according to eq. (8.23) with governing condition (b) 

kN195.2101658.8dfF 322
hk,headRk,ax =⋅⋅=⋅= −  

Designed bearing capacity for loading perpendicular to nail axis 
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Stability analysis for uniaxial bending without compressive force acc. to 6.3.3 
The lateral buckling design is performed for uniaxial bending about the member axis y. 

The middle of the third span is determined as governing location. The bending stress on the 
location X = 11.929 is 6.5 N/mm2 (see page 159). 

Slenderness   487.07400
4300260
14078.0
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14.3.3 Other Results Windows 
The remaining results windows as well as the printout report documentation are similar to the 
ones described in the examples presented in chapter 10 and 11. 
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15. Brace 
The program RX-TIMBER Brace is also explained by an example: A stiffening brace is stabilizing 
the fish beam described in chapter 10.2 

The model data is stored in the model 01.vrb of the project Examples RX-TIMBER. We find it 
among the example files of the program Brace. 

The short cantilever of the fish-bellied girder is structurally stiffened by an eaves board. The re-
sulting load is directly transferred into the support. 

15.1 System and Loads 

 

Figure 15.1: System 

Model  

 Cross-sections Material 

Upper/lower chord 20/39 cm GL 24c 

Verticals 12/12 cm C 24 

Diagonals Round steel bars 20 mm S 235 

(Note: Half of the cross-section depth is used on the support for the chord.) 

Roof shape:  Monopitch roof with cantilevers 

Building dimensions 

Height:   6.0 m 

Depth:   40.0 m 

Geometry 

Brace width:  4.8 m 

Length:   15.0 m 

Roof inclination:  5.0° 

Cantilever length left: 0 m 

Cantilever length right: 2.17 m 

Inner span length:  3.0 m (in floor plan) 

Number of bays:  5  
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Loading 
The corresponding equivalent load is directly taken from the fish beam model 08.gl that we 
find among the example files of the program RX-TIMBER Glued Laminated Beam. 

Load case   1: self-weight and roof finishes  qg      = 0.08 kN/m LDC = permanent 

Load case 41:  snow load  qs     = 0.04 kN/m LDC = short-term 

Load case 56:  wind parallel to ridge (A) qw(p,A)= 0.04 kN/m LDC = short-term 

Load case 56:  wind parallel to ridge (B) qw(p,B)= 0.03 kN/m LDC = short-term 

The wind loads are determined automatically by the load generator integrated in the program. 
To be on the safe side, they are applied only on the inner span of the bracing. 

 

Figure 15.2: Wind load only in span 

With the option Number of Braces More than one (in window 1.7 Loads) the wind loads "pressure 
on gable" (LC55) and "suction on gable" (LC56) are separately applied to the front respectively 
rear girder. The program automatically creates two new load cases, LC155 and LC156. 

 
Figure 15.3: Number of braces 

Equal load cases with reverse action directions are automatically created for other load cases, 
too. A changed load direction may have a positive effect especially with failing steel diagonals. 
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15.2 Input of Model Data 

15.2.1 General Data 
Start the program by double-clicking the desktop icon Dlubal RX-TIMBER 2.xx (see chapter 3.2, 
page 12), and then select Brace in the Project Manager. 

 
Figure 15.4: Window 1.1 General Data 

For the Roof shape we select a Monopitch roof with Cantilevers. 

We want to analyze the girder according to DIN EN 1995-1-1. 

We click the [Edit] button shown on the left to open the dialog box National Annex Settings 
where we can check the standard's parameters (see figure below). 
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Figure 15.5: Dialog box National Annex Settings - DIN EN 1995-1-1 

In accordance with clause 9.2.5 of DIN EN 1995-1-1, a deformation analysis for stiffening brac-
ings must be performed also for the ultimate limit state design if we don't carry out any more 
accurate design. We restrict the deformations to l/500 in the dialog section Limit Values of  
Deformations. 

A limit of l/1000 is preset for the serviceability limit state design. In accordance with clause 7.2 
of the standard, we could also calculate with l/200 or similar values. In this case, the servicea-
bility limit state design would no longer be governing, of course, because then the mean val-
ues of the stiffnesses would be used for calculating the deformations. However, for the com-
mon setting of l/1000 as limit deformation there are still some cases imaginable where the ser-
viceability limit state design becomes governing. 

To avoid creating a multitude of combinations, we want to combine the load cases for the 
characteristic situation including all loads so that all defined load cases are always combined. 
So a division into the other design requirements of the standard is not necessary. 
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Figure 15.6: Window 1.1 General Data, list Brace Type 

We define the Brace Type by using the list. 

The variant with steel ties requires a nonlinear calculation. Therefore, load combinations are 
automatically created for this brace type. But the calculation is still performed according to lin-
ear static analysis. 

The nonlinear calculation takes into account that a tension member is no longer effective in 
the system if a compressive force occurs in the member. Then, the model will be calculated 
without this tie in the following iteration steps. 

Strictly speaking, the steel ties are truss girders with the member nonlinearity "failure under 
compression" as they can transfer also bending moments outside the plane. 

 
Figure 15.7: Failure under compression 
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15.2.2 Geometry 

In the second program window, we enter the geometry of the bracing. 

 
Figure 15.8: Window 1.2 Geometry 

We set the geometry Parameters according to the system description on page 162. 

To keep the effort for input as low as possible, we tick the check boxes for Identical bay lengths 
and Regular diagonals. 

If the boxes are clear, it is possible to combine any descending, crossing or ascending diagonals 
in freely definable bays: 

 
Figure 15.9: Window section Parameters with different types of diagonals 
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15.2.3 Materials 
In window 1.3, we define the materials of the cross-sections. As timber and steel are often used 
together in bracings, RX-TIMBER Brace offers us the entire range of steel grades. 

 
Figure 15.10: Window 1.3 Materials 

We access the material library by clicking the button [...] appearing at the end of the input row. 

 
Figure 15.11: Material Library 
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15.2.4 Cross-sections 
Cross-section types can be selected in a library by placing the pointer into the table row and 
clicking the [...] button. It is also possible to enter cross-sections directly in table column A. 

 
Figure 15.12: Window 1.4 Cross-Sections 

 
Figure 15.13: Cross-Section Library 

Unacceptable or illogical cross-sections are highlighted in red in window 1.4. 

 
Figure 15.14: Incorrect cross-sections highlighted in red 
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15.2.5 Connections 
We can define the connections separately for verticals, diagonals and crossing diagonals. 

 
Figure 15.15: Window 1.5 Connections 

In table column A Components, we specify the type of connection. 

In table column B, we can decide if the stiffnesses are User-defined or determined by the pro-
gram. If we want RX-TIMBER Brace to calculate the stiffnesses, a database with connecting ele-
ments is provided. In this case, the eccentricities and connection values must be set manually. 
The eccentricities always refer to the start node of the bay. 

For the Crossing diagonal we enter an eccentricity of 0.500 m in the global direction X', and 
another of 0.250 m in the global direction Y'. We don't modify the translational or rotational 
spring stiffnesses. 

  
Figure 15.16: User-defined input of Connection Details 
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Excursus: 

A connection with through bolts can be modeled in different ways. 

 

Figure 15.17: Details of through bolt 

This connection can be represented by three variants: 

 

Figure 15.18: Modeling of eccentricities 

1. The static base structure of RX-TIMBER Brace is used without considering eccentricities 
(simplest possibility). 

2. A member eccentricity is defined for the tension member. 

3. A new member with a very high stiffness is inserted for modeling the eccentricity. 

Variant 3 provides very realistic results (see figure below) but involves considerable effort. It 
would be very difficult to do this kind of modeling in RX-TIMBER. Therefore, variant 2 is availa-
ble in the program to be a feasible and quick modeling option. 
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Figure 15.19: Internal forces and deformations for variants 1 to 3 (from the left to the right) 

As you can see, variant 3 offers very realistic results. Variant 2 provides similar results, in particu-
lar for the deformations that are relevant for the brace. In variant 1, results are clearly different. 
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15.2.6 Components 
Now, we assign the previously defined connection to the components. 

 
Figure 15.20: Window 1.6 Components  

For the crossing diagonals we select connection 1 for the Start and End of the members. 

If you want to define the eccentricity of a member individually, you can assign a distinct con-
nection to each member in the window section Option. If the check boxes are ticked, it would 
also be possible to assign each cross-section as you want (see figure below). The cross-sections 
have to be defined previously in window 1.4 Cross-Sections. 

 
Figure 15.21: Assigning structural components individually 

However, the individual modeling involves a considerable modeling effort. 
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We use the button [Preview of releases] to look at the members with the defined eccentricities 
and stiffnesses in a table. 

 
Figure 15.22: Dialog box Releases 

Buttons for window graphic 

In window 1.6 Components, like in all other program windows offering a graphical representa-
tion of the brace, we see several buttons to the right of the graphic (see Figure 15.21). 

In the rendering display, it is difficult to see whether the release has been assigned to the cor-
rect member end. Therefore, a model display reduced to the centerlines is possible in addition 
to the photo-realistic view. In the wireframe display model we see the members displayed as 
lines so that releases can be clearly recognized. We can switch between both display options 
with the [Display] button. 

We use the button [Show Dimensions] to display the dimension lines on the bracing. 

To turn on and off the numbering of nodes and members, we click the button [Show Number-
ing]. 

The girder's view can be changed by using the [View] buttons for the directions -Y and Z. Then, 
the graphic shows the brace displayed in the selected viewing direction. 

The button shown on the left sets the isometric view. 

We use the final button to reset the display of the entire model. This function is useful when a 
maximized partial view was set, which is possible by using the wheel button of the mouse. 
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15.2.7 Loads 
In window 1.7 Loads, we have to specify several entries. 

 
Figure 15.23: Window 1.7 Loads 

In the window section Number of Braces, we define how many bracings are provided for the 
stiffening of the truss. For the normal case of a quadrilateral hall it would be reasonable to dis-
tribute the loads from wind flows among the braces. Therefore, we tick the check box More 
than one. 

Due to the hall depth of 40 m defined in window 1.2, there are two braces each with four truss 
girders that must be stiffened by the bracing. Therefore, we enter the number 4 in the window 
section Equivalent Loads. 

We click the [Info] button to open a dialog box illustrating the load application. 

 
Figure 15.24: Dialog box Number of members for one brace 
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In the window section Equivalent Loads, we use the check boxes to decide if a load case is used 
for the automatic combination. The Use options are especially helpful for user-defined loads 
because this setting won't be overwritten by RF-COMBI. 

 
Figure 15.25: Window section Equivalent Loads 

Here, it is recommended to Use load case 1 and the wind loads blowing on the gable. In most 
cases, they result in the governing deformations of the brace. 

We can hide the used loads by clicking the buttons [Hide Zero Values] and [Hide Unused Values]. 

In window 1.7, we continue with setting the Imposed Load Category affecting the automatic 
superpositioning. When ticking the option North German Plain for the snow load below, an ac-
cidental combination is automatically created in RF-COMBI. Then, also the stiffnesses of the re-
leases and of the materials with the characteristic stiffnesses are recalculated. 

Like in other programs of the RX-TIMBER family the Wind Load is generated automatically, but 
it is also possible to define it manually. 

We click the [Info] button to open the wind zone map of Germany. The relevant zone can be 
taken over by double click.  



15  Brace 

 

 

177 Program RX-TIMBER © 2013 Dlubal Software GmbH 

 
Figure 15.26: Wind zone map for Germany 

The wind load is automatically interpolated for the selected roof inclination of 5°. Thus, in accor-
dance with DIN EN 1991-1-4, we have the following values for the pressure and suction areas: 

Gust velocity pressure for wind zone 1 q(z) = 0.5 kN/m2 
External pressure coefficient for area D cpe,10 = 0.69  (interpolated for roof inclination of 5°) 

External pressure coefficient for area D cpe,10 = 0.27  (interpolated for roof inclination of 5°) 

Wind pressure cpe · q(z) = we,D = 0.34 kN/m2 
Wind suction cpe · q(z) = we,E = 0.14 kN/m2 

Based on these factors and according to the building height defined in window 1.2 Geometry, 
the program calculates the wind load on the brace. To simplify the calculation, the program 
applies the half of the height of the eaves as well as the half of the height on the ridge to the 
load application area. 

 
Figure 15.27: Scheme for load application area 

Entering wind loads manually is also possible for more accurate load applications like of a con-
crete ring beam for which only half of the load application area would have to be considered. 
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In our example, the settings result in the following load ordinates for the wind pressure zone 
(LC 155) with: 

m/kN02.1)5cos3(²m/kN34.0cos
2
H

wp D,e1 =°⋅⋅=α⋅⋅=  

The discrepancy of 0.03 kN/m results from the roundings in the manual calculations. 

The load ordinate of the eaves for an eaves height of 5.33 m is: 

m/kN89.0)5cos65.2(²m/kN34.0cos
2
H

wp E,e2 =°⋅⋅=α⋅⋅=  

 

Figure 15.28: Load of wind pressure for brace 1 

The load ordinates for the wind suction zone (LC 56) are the following: 

m/kN42.0)5cos3(²m/kN14.0cos
2
H

wp D,e1 =°⋅⋅=α⋅⋅=  

The load ordinate of the eaves with the eaves height of 5.33 m is the following: 

m/kN37.0)5cos65.2(²m/kN14.0cos
2
H

wp E,e2 =°⋅⋅=α⋅⋅=  

 

Figure 15.29: Load of wind suction for brace 2 

The required equivalent load can be calculated according to eq. (9.37) of DIN EN 1995-1-1: 

l30

Nn
kq d

ld ⋅
⋅

⋅=  

Alternatively, we can insert the values from window 2.4 Support Forces of the RX-TIMBER Glued 
Laminated Beam program into window 1.7 by using the clipboard (Ctrl + C and Ctrl + V). 
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Figure 15.30: Window 2.4 Copying Support Forces in program RX-TIMBER Glued Laminated Beam 

We use the button [Show Generated Loads] shown on the left to open the dialog box Load 
Cases where we can check the generated loads. 

 
Figure 15.31: Dialog box Load Cases 

Here, we can freely define the loads like in all other programs of the RX-TIMBER family. 
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15.2.8 Control Parameters 
In window 1.8 Control Parameters, we set only the design of the Ultimate limit state. Usually, 
this design is sufficient because the program also analyzes the limitation of the deflection to  
u < l/500 according to clause 9.2.5 of DIN EN 1995. 

 
Figure 15.32: Window 1.8 Control Parameters 

We click the button [Nat. Annex] to open the dialog box National Annex Settings (see Figure 
15.5, page 165) where we can define the partial safety and modification factors as well as the 
limit deformations. 

When determining the stiffnesses RX-TIMBER performs a double calculation of the internal 
forces and deformations: 

When designing the ultimate limit state we have to calculate, in accordance with clause 2.2 of 
EN 1995-1-1 or clause 8.2 of DIN 1052, with the mean stiffness that is to be divided by the par-
tial safety factor. In the serviceability limit state design, however, we have to apply the charac-
teristic mean stiffnesses. 

The combinatorics for the serviceability limit state design is globally solved in the program  
RX-TIMBER Brace with the rare characteristic combination according to EN 1991, respectively 
DIN 1055. The equation (22) according to DIN 1055-100 is: 

Equation 15.1: Combination expression according to DIN 1055-100 for rare (characteristic) combination 

Furthermore, note the following for the slip moduli Kser of the release stiffnesses: They must be 
divided as well by the partial safety factor 1.3 in the ultimate limit state design. For the service-
ability limit state design the program calculates with the characteristic displacement of Kser. 

RX-TIMBER calculates the data in a double calculation loop: In the first calculation run, the in-
ternal forces and deformations are determined in the ultimate limit state design on the design 
level. In the second calculation run, the program overwrites this stiffness of the materials and 
end releases and calculates the deformations with the characteristic stiffnesses. 
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15.2.9 Effective Lengths 
To be on the safe side, we select the factor β with 1.0 in our example. The values are preset by 
the program so that no data modification is required in this window. 

 
Figure 15.33 Window 1.9 Effective Lengths 

15.2.10 RF-COMBI 
We use the button [RF-COMBI] shown on the left to access the add-on module RF-COMBI inte-
grated in RX-TIMBER. In RF-COMBI we can check the combinations generated in the program's 
background. 

 
Figure 15.34: RF-COMBI window 1.2 Load Cases in Actions 

In the list with the created cases (top left), two cases are available for the ultimate limit state 
design: As already mentioned in chapter 15.1, members may fail in particular load arrange-
ments. To cover all eventualities, all loads are applied again in the reverse direction and com-
bined automatically. 

For more detailed information about the features of RF-COMBI, see the manual available for 
download at www.dlubal.com. We click [OK] to return to RX-TIMBER Brace. 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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15.3 Results 

15.3.1 Load/Result Combinations 
We use the [Calculation] button to calculate the entered data. Window 2.1 shows the ultimate 
limit state designs for all combinations together with the respective design ratios. As already 
mentioned, RX-TIMBER automatically creates load combinations in case of a material nonline-
arity (which means failing tension members). Then, window 2.1 is renamed in Load Combina-
tions. 

Load combination 
CO 

A load combination is used to superimpose load cases, that means all 
loads of the load cases in question are summarized. 

Result combination 
RC 

A result combination sums up the results of the contained load cas-
es. Therefore, always two result values per location are available: 
maximum and minimum. 

It is possible to determine the extreme internal forces and defor-
mations from different load cases, load or result combinations by an 
Or combination. 

Table 15.1: Difference between load and result combination 

When we perform a linear calculation, it does not matter which type of superposition is select-
ed. But for a nonlinear calculation it is only the load combination that provides reasonable re-
sults! 

 
Figure 15.35: Window 2.1 Load Combinations 
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15.3.2 Design - All 
Window 2.2 Design - All shows us an overview about the governing designs for each design 
situation. In this way, we can see overloaded areas immediately. 

 
Figure 15.36: Window 2.2 Design - All 

We have different possibilities for filters and result diagrams to evaluate the results (see chap-
ter 7). 

Please note the following for the Result Diagrams on Member: It is not possible to represent all 
results in the result diagram because RX-TIMBER Brace uses lots of members. Therefore, the re-
sult diagrams show only the results of the member that is selected in the current program 
window. If we place the pointer in the table row of member 13 as shown in the figure above 
and open the result diagram, the diagram window only shows us the internal forces and de-
signs for member 13. 

 
Figure 15.37: Result diagram on member 13 
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15.3.3 Design by Components 
The results window shows the governing designs for the structural components Front flange, 
Rear flange, Verticals and Diagonals. 

 
Figure 15.38: Window 2.3 Design by Components 

15.3.4 Design by Cross-Section 
Window 2.4 lists the designs sorted by cross-sections. 

If no individual settings were specified in window 1.6 Components, this results window repre-
sents the clearest and most helpful table where the results in our example are listed separately 
for chord, verticals and diagonals. 

 
Figure 15.39: Window 2.4 Design by Cross-Section 
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15.3.5 Design by x-Location 
The number of x-locations set in window 1.8 Control Parameters has an effect on the amount of 
data displayed in window 2.6. 

 
Figure 15.40: Window 2.6 Design by x-Location 

The stress and stability analyses are already presented in previous examples. That's why we 
want to have a closer look at the most interesting bracing designs such as the analysis of de-
flection in the ultimate limit state design. 

Analysis of deformation according to DIN 1052, paragraph 8.4.3(9)  
If we don't perform a design that is more accurate, the calculated deflection from qd and other 
external actions must not exceed l/500. 

Here, the stiffnesses are applied on safety level by the program. 

Stiffness properties Properties for ultimate limit state Mean values 

Modulus of elasticity 
M

meanE
E

γ
=  Emean 

Shear modulus 
M

meanG
G

γ
=  Gmean 

Slip modulus 
M

mean,u
mean,u

K
K

γ
=  sermean,u K

3
2

K ⋅=  

The mean values of the stiffness can be found in annex F of DIN 1052, respectively EN 388 or 
EN 1194. 
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In our example, we get the following stiffness properties for load bearing capacity, serviceabil-
ity and fire resistance of the respective components as shown in the table below.  
The stiffness properties of the fire resistance are to put on the same level with the ones for an 
accidental combination. 

Component Material Load bearing capacity Serviceability Fire resistance 

Chord GL24c ²cm/kN892
3.1

1160
E ==  Emean = 1160 kN/cm2 Emean 

 ²cm/kN454
3.1

590
G ==  Gmean = 590 kN/cm2 Gmean 

Verticals  C24 ²cm/kN846
3.1

1100
E ==  Emean = 1100 kN/cm2 Emean 

 ²cm/kN531
3.1

690
G ==  Gmean = 690 kN/cm2 Gmean 

Diagonals S235 ²cm/kN19091
1.1

21000
E ==  E = 21000 kN/cm2 - 

 ²cm/kN7364
1.1

8100
G ==  G = 8100 kN/cm2 - 

Connection 
- 

M

mean,u
mean,u

K
K

γ
=  Kser Ku,mean 

The governing load combination CO4 with the actions 1.35 · LC101 + 1.5 · LC155 features the 
following loads, internal forces and deformations. 

Loads 

 

Figure 15.41: Loads 
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Deformation 

 
Figure 15.42: Deformations uY 

Internal forces 

 
Figure 15.43: Axial forces N 

 

Figure 15.44: Moments MZ 
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Deformation analysis 
The deformation in the lower chord member 3 in direction Y is calculated by the program with 
7.7 mm. The deformation of the tension diagonals is larger, of course, but irrelevant for the to-
tal deformation. Thus, we obtain the following design ratio: 

Deformation = winst = -7.7 mm 

Limit value = winst,limit = l/500 = 15.06 m / 500 = 30.1 mm 

Design ratio 

winst / winst,limit = 7.7 mm / 30.1 mm = 0.26  =>  26 % design ratio 

The girder is sufficiently stiff for the deformation analysis. 

Design of tension members 
As we can see in Figure 15.43, several diagonals are failing under the load, which means that 
they do not provide any internal forces. 

The maximum tensile force occurs on the diagonal member 21 (left bay) with a force of 18.02 kN. 

Tensile stress N / A = 18.02 kN / 3.14 cm2 = 5.74 kN/cm2 

Design ratio 

126.0

1.1

²cm/kN24
²cm/kN74.5

²cm/kN24
²cm/kN74.5

f

M

d,y

t,N <==

γ

=
σ

 

The member is used with a capacity of 26 %. 

We do not analyze the chord because it has already been designed in the program RX-TIMBER 
Glued Laminated Timber. However, we need to consider the axial forces of the brace in a recal-
culation with RX-TIMBER Glued Laminated Timber. 
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15.3.6 Support Forces 
Window 2.7 Support Forces is the final results window. The support forces are shown for all four 
supports of the brace. 

In addition, a max/min evaluation of forces is displayed. In this way, the forces to be transferred 
can be quickly determined. 

 
Figure 15.45: Window 2.7 Support Forces 

15.3.7 Printout Report 
The printout report documentation is similar to the one described in the examples presented 
in chapter 10 and 11. 
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